TECHNICAL SUPPORT

If you are experiencing problems with this software and have followed the instructions in this manual carefully, please call our
customer support help line and speak with one of our technical support representatives, or alternatively visit our website at
http://www.xicat.com where the majority of common problems and solutions will be displayed.

When you contact our support line, please try to have information about your PC configuration available, together with a
detailed description of the problem you are experiencing. If at all possible, try to be seated in front of your computer. Our
representatives will endeavor to structure their instructions according to your level of PC competency, but it may not be
possible to avoid technical jargon. Always have a pen and paper ready to take down their instructions.

Xicat Interactive Customer Support is available from 9:30 a.m. — 5:00 p.m. (EST) M-F with the exception of national holidays.
The number is (954) 522-3900.

SOFTWARE LICENSE

This agreement sets forth the license terms and conditions for using the enclosed software. By using the enclosed software, you agree to be
bound by the terms of this license.

Xicat Interactive grants you a non-exclusive, non-transferable license to (a) use the Software on a single computer, (b) physically transfer the
Software from one central processing unit (CPU) to another (which will then be designated CPU); (c) make one copy of the Software for backup
purposes. You must place the same copyright information on the backup copy. You may not electronically transfer, sell, assign, rent, lease or
otherwise distribute copies of the Software or documentation to others. The Software was designed and licensed for use on a single user
computer system. Xicat Interactive makes no warranties with respect to the performance of the Software on networked computers or in multiple-
user or multiple-CPU operating environments.

NOTICE
Xicat Interactive reserves the right to make improvements in this product described in this documentation at any time and without notice.

PROPRIETARY RIGHTS

The Software and documentation are copyrighted by and proprietary to Xicat Interactive and/or our suppliers. Xicat Interactive and/or our
suppliers retain title and ownership of the Software and documentation. You acknowledge that the Software and documentation contain valuable
trade secrets and other proprietary information belonging to Xicat Interactive and/or our suppliers. You agree to hold the Software in confidence
and to take reasonable steps to prevent disclosure to others.

NO OTHER RIGHTS

Except as stated above, this agreement does not grant you any rights to patents, copyrights, trade secrets, trade names, trademarks (whether
registered or unregistered), or any rights, franchises or license with respect to the Software and documentation. Xicat Interactive reserves all
rights not explicitly granted in this license agreement.

TERM

The license granted under this agreement is effective until terminated. You may terminate the license at any time by destroying the Software and
documentation in your possession or subject to your control together with copies or modifications in any form. Xicat Interactive may terminate
your license immediately if you fail to comply with any term or condition of this agreement. You agree that upon any such termination you will
destroy the Software and documentation in your possession or subject to your control together with all copies or modifications in any form.

WARRANTY DISCLAIMER AND LIMITATIONS OF LIABILITY

Warranty disclaimer: Although we have tested the Software, neither Xicat Interactive nor anyone else involved in the creation, production,
delivery, or licensing of the Software or documentation make any warranty or representation of any kind, expressed or implied with respect to the
Software or documentation, or it's quality, reliability, title or performance, or it's merchantability or fitness for any particular purpose or application.
As aresult, the Software and documentation is licensed "as is", and you, the licensee, are assuming the entire risk as to their quality and
performance, you, and not Xicat Interactive, assume the entire cost of all necessary services or repairs.

Limitation of Liability: In no event will Xicat Interactive or anyone else involved in the creation, production, delivery or licensing of the Software or
documentation to be liable to you for any direct, indirect, special, incidental, or consequential damages of any kind arising out of use of the
Software or documentation, even if the Software or documentation or any defect in the Software or documentation, even if Xicat Interactive or
anyone else involved in the creation, production, delivery, or licensing of the Software or documentation has been advised of the possibility of
such defects. In particular Xicat Interactive will have no liability for any hardware, software or data stored or used with the Software, including the
costs of repairing, replacing or recovering such hardware, software, or data.

© 2000 Xicat Interactive, Ltd., 800 East Broward Blvd., Suite 700, Fort Lauderdale, FL 33301. All Right Reserved.
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MISSION STATEMENT

So you need to keep your instrument flying skills up to date and you don't relish paying $80.00/hour to keep
going up with instructors for instrument currency?

So you want to keep your airmanship skills up to date and want a good sim to do it in without paying
$50.00/hour?

So you fly a Glasair homebuilt and you've noticed that there are no instrument trainers for your airplane? Maybe
you don't need instrument training, but just want to fly the Glasair on the sim a few times before you take it up for
real!

Maybe you're getting your helo lessons and want to practice hovering in the R-22 to get your hovering and helo
airmanship skills up to speed before your first solo, or even before your next flight.

Maybe you want to design and test-fly your own aircraft concept?

Maybe you love flying, can't get enough of it, and want to fly the sim when you're not in the real plane.
If you want any of these things or more, X-Plane is for you.

The X-Plane design system is based on the following principals:

e You measure the dimensions of any airplane.

e You enter those dimensions into the computer.

e You fly the airplane on your desktop.

X-Plane was designed to simulate aircraft by using an engineering process called "blade element analysis", a
procedure frequently used by engineering companies to predict the performance of aircraft propellers and
helicopter rotors. The process is actually quite simple: The propeller or rotor blade is broken down into a number
of pieces (usually about 5 to 20), and the exact speed of each "piece" is found by considering the movement of
the airplane and the rotation of the propeller. Once the speed and angle of attack of each piece of the propeller
are known, the forces on the propeller can be found. X-Plane uses this theory not just on the propeller, but also
on the entire aircraft. The props, rotors, wings, horizontal stabilizer, and vertical stabilizers are each broken down
into several pieces and the forces are found on each piece. These forces are then added up to give the total
force on the aircraft. Once the total forces on the aircraft are known, X-Plane can easily determine what the
aircraft will do next.

The flight physics of X-Plane are designed to handle subsonic, compressible, and even supersonic flow, so the
flight-model is good across a wide range of mach numbers from the 96 knots of the Cessna 152 to the
Mach-2.02 flight of the Concorde. Rolls and stalls are possible, although loops and spins are not entirely
accurate due to the limitations of Eulerian flight propagation and turbulence simulation, respectively. (Eulerian
flight propagation, which X-Plane uses, has a hard time tracking the heading when you are pointed straight up,
and the turbulent airflow of a stalled wing is still not completely mathematically simulate-able by any computer).



System Requirements for the X-System

Minimum System Requirements:

X-Plane 5.52 X-Plane Classic
Windows CPU Pentium 300 Pentium 150
Macintosh CPU Power Mac 200 Power Mac 100
RAM 96 MB 32 MB
Disk Space 80 MB 20 MB
CD ROM 2X 2X
Video Open GL Compatible Any

with at least 8 MB of

Video Memory (VRAM)
Monitor 800x600 800x600
Joystick/Yoke Optional Optional

The Lowdown:

X-Plane 5.52 is a 3-D accelerated program, which means that it needs a decent CPU and a 3-D accelerator card to run. 3-D
accelerator cards are designed specifically to do high-speed graphics, so they work many times faster than your CPU ever
could. The three languages of 3-D accelerator cards are OpenGL, Direct-3D, and Glide.

X-Plane Classic is an older version of X-Plane that does not have the modern 3-D graphics, so does NOT require a 3-D card
with OpenGL. Both X-Plane 5.52 and Classic come on your X-Plane CD, so you can use version Classic now if you have an
older machine, and switch to version 5.52 later when you upgrade machines or get an OpenGL 3-D accelerator card.

The faster your CPU, the better the frame-rate, so get a fast Pentium or Power-Mac if possible. Pentiums are OK, Pentium-II's
are nicer, Pentium -llI's are great.

In the Mac world, Power-Mac's are nice, G-3's are really nice, and G-4's rock incredibly. I-Macs with the Rage-PRO cards are
OK, and I-Macs with the Rage-128 cards are great!

X-Plane will be better if you install speech synthesis on your machine. This will give verbal Air Traffic Control!

Windows Users:
Get speech synthesis: Microsoft Speech Engine (40 meg!) (ftp:/ftp.prisidian.net/links/microsoftspeech4.exe)

Mac Users:
Install the Apple Speech Manager, using the apple system installer on your system CD...you can opt to install the speech
manager ONLY.

Check our website for news on the latest and recommended graphics cards, and use X-Plane CLASSIC if you do not have a
required 3-D card.

Some remarks about peripherals
On Apple systems you can use any joystick you like with X-Plane 5.52, or stick to CH-Products, Gravis, or Thrust-Master
joysticks if you are using X-Plane CLASSIC. If you have no joysticks then you can simply fly with the mouse (click in the center

of the windshield) or keyboard (using the numeric keypad).

On Windows you can use any joystick, yoke, or rudder pedals that you can calibrate in Windows. (On your desktop, go to “My
Computer” / “Control Panel” / “Game Controllers” to calibrate your joystick).

You can also use the "Fly-It" instrument panel if you want a panel for your PC. Call Fly-It at 760434-1940 or see: www.flyit.com.

For helicopter controls, Flight-Link makes a cyclic stick and collective control, and can be reached at 530-891-4987 or
www.flight-link.com.

For throttle quadrants, Flight-Link makes one that works with X-Plane, and can be reached at 530-891-4987 and
www.flight-link.com.

For a hydraulic chair that pitches and rolls as the aircraft does in X-Plane, check out www.tvcknride.com.



Installation

Windows Users:
Insert the CD into your CD ROM drive and choose one of the following install options to install X-Plane.

1. If your CD ROM drive has AutoPlay enabled, the launch screen will appear automatically. Click install and
follow the on-screen installation instructions.

2. If AutoPlay is not enabled, double-click on the “My Computer” icon on your desktop. Double-click on the
CD ROM drive icon. Double click on “Setup” icon. Click install and follow the on-screen installation instructions.
3. You may also install X-Plane directly from the self-extracting executable files on the CD. Double-click on the
“My Computer” icon on your desktop. Double-click on the CD ROM drive icon. Double-click on either the “X-
Plane 552 Windows” icon or the “X-Plane Classic Windows” icon. The version you choose to install will be
based on your system. Please read the System Requirements for more information. These files will
automatically extract to their own directories on the hard drive you choose.

Macintosh Users:

Just double-click on the file on the CD for the appropriate version of X-Plane. The version you choose to install
will be based on your system. Please read the System Requirements for more information. When asked what
directory to extract the file to, simply choose the hard drive of your computer or wherever you want X-Plane to be
installed.

Macintosh and Windows users:

If you are running X-Plane 5.52 and experience a crash at runtime, you probably need up-to-date drivers for your
video card. Go to the website of the manufacturer of your video card, and follow the instructions carefully for
installing their latest drivers. The driver that came with your video card is probably obsolete already (because of
the high advance time on production).

The latest version of Microsoft Direct-X at www.microsoft.com is also a common solution for PC users.

Do not change the names of the "additional nav data" folder or the folders within it. Ditto this on the "airfoils",

"flaps", "planes"”, "bitmaps", "textures", and "sounds" folders. X-Plane needs these folders to get to it's
scenery, graphics, airplanes, and sounds.

The "additional nav data" folder contains ".env" files, (scenery files), "apt.dat" (airport data), "nav.dat"
(NAVAID data) and "fix.dat" (fix data) files, as well as any custom objects and textures. Most of the scenery for
the world is on the X-Plane CD in the form of thousands of ".env" files, but any ".env" files in the "additional nav
data" folder overrides the data on the CD. This allows you have your own custom-edited scenery that overrides
the default scenery on the CD.

World-Maker will allow you to edit scenery, and the scenery files that you edit will be in the "additional nav
data" folder where they can over-ride the standard scenery on the CD.

Part-Maker will allow you to create and edit airfoils and flaps, which sit in the "airfoils" and "flaps" folders.
Plane-Maker will allow you to create and edit airplanes and helos, which sit in the "planes” folder.
Note: X-Plane reads scenery data from the CD-ROM periodically as you fly and checks the disk for copy

protection. You must therefore leave the X-Plane CD in your CD ROM drive. Removing the CD will put X-Plane
in demo mode!



YOUR FIRST FLIGHT

Windows Users
Click on the “Start” button in your Windows toolbar. Select “Programs” / “X-Plane” / “X-Plane 552" or “X-Plane
Classic” (Depending on the version you installed.)

Macintosh Users
Double-click on the "X-Plane" icon on your hard drive, thus launching X-Plane. X-Plane will be in your
"X-System" folder, which is wherever you just extracted it to.

Quick Flight

X-Plane begins with a “Quick Flight Options” window. From this menu you can set your weather options,
choose your airport as well as your aircraft. For this demonstration, choose the default Cessna 172 which is
spinning in the menu. After you have made your option selections, click “Go To This Airport Now”.

Wait until you are settled on the runway in a Cessna 172.
Disengage the brakes. (Click the red brake button.)

Operate the throttle with the mouse or joystick. You can
configure your joystick in the “Settings” “Joystick Axis...” 4 122
and “Hardware & Flight Mode” menus. (The throttle is the \ : ]
gray knob on the lower-right... drag it up all the way to go
to full power.)

” o«

Pull the joystick lightly to rotate and take-off at about 60
knots.

Upon reaching 3,000 feet or so throttle back to 75%.

midnight

Fly the plane for a few minutes with the joystick.

Now you can fly the simulator.
Select "Quit" from the "File Menu".
Open "Plane-Maker". Plane-Maker is located in the same location where you found X-Plane. Go to the "File"
menu and select "Open". Select the Cessna 172 from the "General Aviation" folder. Select "Wing 1" from the
"Design" menu. Reduce the length a bit, and/or make any other changes you want. Select "Save As" from the
"File" menu. Type in "Modified Skyhawk" for your new modified airplane after backspacing over the earlier
name and press Return.

Now you know how to edit your own airplane designs.
Select "Quit" from the "File" menu.

Open "X-Plane" again.

Select "Open Aircraft" from the "File" menu.

Choose the airplane that you just saved in Plane-Maker.

Fly it. (If you still can!)

Now you are an aircraft designer and test pilot!



CHAPTER 1
X-PLANE EXPLAINED

Operating the Controls

Joystick The joystick, rudder pedals and throttle-quadrant operate the flight controls of the airplane. If you don't
have any such peripherals hooked up, you can use the mouse and keyboard instead. To use the mouse, click in
the center of the windshield and you will be able to fly the plane with the mouse that way. Click again in the
center of the windshield to stop flying the plane with the mouse. You can use the numeric keypad to fly the plane
with the keyboard.

It is very important to calibrate your joystick before flying X-Plane! Do this using the regular control panels for
your joystick and operating system. (Windows users should go to "My Computer” / “Control Panel” / “Game
Controllers").

Keyboard

Keyboard use is not required. Command key equivalents, if any, are listed in the X-Plane menus. There are also
command key equivalents for views in the "View" menu. They are surrounded by brackets like this: "[W]". Just hit
those keys without hitting the shift, option/alt or control keys to select those views.

The default key layout, which is referred to for the rest of this manual, is for the US English keyboard, which
means that international users may find keys in different locations. If you have a French or German keyboard,
then you can switch to that key layout in the "Hardware and Flight Mode" window in the "Settings" menu. This
will change the keys used in X-Plane to map to the same locations on your keyboard despite being different
actual letters of the alphabet. To see where on the keyboard the keys will go, look at the English key layout to the
right when referring to the American keyboard shortcuts.

NOTE: Not all airplanes use all keys. In X-Plane different cockpit configurations may require a subset of all
available keys! For example, a Cessna 172 does not have wing-sweep and a B-52 does not have carb heat.

Enter/Return activate ATC if not up already % autopilot nav course 1
Enter/Return accept ATC blinking selection A autopilot nav course 2
Enter/Return close/open a window & autopilot alt hid
arrow keys select an ATC option * autopilot glide slope 2
arrow keys rotate view angle if in Free-View

or Spot View from the View menu Q W E R (shifi-key!) com 1 radio frequency
Spacebar kill engine TYUI nav 1 radio frequency
5 (point) reverse thrust (if available) ASDF com 2 radio frequency
yu (smallcaps!) adjust directional gyro (heading) GHJK nav 2 radio frequency
io adjust barometric pressure OPL:>? ADF frequency
hj adjust OBS 1 ZXCVBNM<  transponder setting
kl adjust radar altimeter bug
nm adjust OBS 2 12 Flaps up or down one
cvVv ADF compass rose 34 Carb heat off or on
p pause 56 Speedbrake up or down one
b brakes 78 Aileron Trim
g gear 90 Rudder Trim
! autopilot disconnect [1 Elevator trim
$ autopilot heading d display en route map

Keyboard commands

Function keys control the throttle, prop, and mixture... with one exception: use the Backspace key instead of
the F10 key in Windows. In Windows, Microsoft reserves the F10 key for menu-operations.



If you have a Flight-Link throttle quadrant, then: “Shift”+ “function key” increases, function key alone
decreases.

F-1/2 increase/decrease all throttles
F-5/6 increase/decrease all props
F-9/backspace key increase/decrease all mixtures

If you fly a helicopter the F-1/2 function key control the collective pitch of the main rotor. Here FI decreases and
F2 increases the pitch. Be sure to have the hardware throttle handle (serving as collective pitch control in helos)

in the full upward position to keep the helicopter on the ground first. Apply the collective pitch very gently with the
mouse, hardware throttle, or function keys to lift off. You should probably find the hover position first by pressing

F2 notch by notch or easing back on the mouse or hardware throttle gradually until the helo lifts off the ground.

Mouse

You can drag engine controls, set frequencies, and manipulate any other on-screen controls with the mouse.
Realize that no one airplane can have all of these controls, so some will be missing from any given airplane. If
you ever wish that the airplane you were flying had additional instruments or controls, go into Plane-Maker and
modify the airplane design to get the features you want in that airplane. Experiment with the many options
available!

Note: For aircraft with reverse thrust, such as the Boeing 737, you need to drag the throttle all the way to
the bottom of the throttle travel with the mouse and hold the mouse button down for a few seconds at the
very bottom of the throttle travel to drop the engines into reverse thrust.

Other Hardware

If you have a Flight-Link panel or collective, a motion cockpit or moving map or other such hardware, be sure to
check out the "Hardware and Flight Mode" and "Serial Output” options in the "Settings" menu. This is where
you can tell X-Plane about your esoteric hardware.

Touring X-Plane

Let's take a tour to see all the instruments. Start X-Plane now. Go to the "File” menu and select "Open Airplane”.
Go to the "Planes" folder and from there to the "General Aviation" folder, and select the "Cessna 172
Skyhawk". This airplane is rather easy to fly and will give non-pilots a good idea of flight instrumentation. We will
use the panel of this aircraft for discussion for the time being.

Menu Bar

The Menu Bar is at the very top of the X-Plane
window. We'll discuss the various options later in
this manual. Here are a few initial remarks:

e Under the "File" menu you can open
airplanes, open and save situations and exit the
simulator.

e Under the "Locations" menu you can place
yourself in different situations and at different
airports. You can fly formation, extinguish forest
fires, land on an oil rig or take-off from an aircraft
carrier. You can get towed by a Husky or
dropped from a B-52.

e Under the "Settings" menu you can quickly
set up weather, visibility, aircraft reliability,
sounds, graphics and your various peripherals.




Status Bar

Look above the scenery, right under the menu bar. This is the status bar. Control sensitivity, flight easiness mode,
the magnetic compass, the aircraft you are currently flying, and the O.A.T. (outside air temperature) are here.

The compass heading is shown in 10's of degrees, so 27 in fact means a magnetic heading of 270', or heading

to the west. In case you forgot, north is 360', east 900, and south 180'. In flight jargon: three-six-zero, niner-zero,
and one-eight-zero. X-Plane's compass simulates magnetic variation and bank-angle-induced error and aircraft
acceleration-induced error, so do not count on the compass when turning or accelerating.

Primary Instruments

Airspeed Indicator
Upper left clock-like instrument. Notice the airspeed arcs (the colored arcs on the edge of the instrument) that
you can use to familiarize yourself with the airplane.

e Vso: The bottom of the white arc is the stall speed with flaps (and
gear) down. In other words it is the stall speed in the landing or "dirty"
configuration.

e Vs: The bottom of the green arc is the stall speed with flaps (and
gear) up. This is the so-called "clean" configuration.

e Vfe: The top of the white arc is the max flap extension speed.
Don't extend your flaps above this speed.

e V/no: The top of the green arc is the maximum normal operation
speed and the max speed in rough air.

These are the “standard-six” primary
flight instruments. Make sure you are
familiar with them before continuing
past this page.

e Vne: The red line is the maximum allowable speed, or the
velocity to never exceed. You can lose your wings above this speed.

Artificial Horizon
This displays the plane's attitude in the air. Note the "level adjust" knob. Use it on the ground to adjust the
"nose-level" or horizontal reference to your liking.

Altimeter

Reading 1,400 feet above sea level, note its barometric pressure
setting knob. Use it to adjust the altimeter setting. The barometric
pressure is preset to 29.92"/ 1013,2 mbar (hPa), the standard
altimeter setting. The altimeter should be adjusted for the local
barometric pressure from time to time. Get the barometric pressure by
checking ATIS, which can be done by hitting the “Enter” key to
activate radio communications.

Flaps have a significant effect on
both lift and drag. The first bit of
flaps (say 10°, or 1 notch) increases
the lift (upward force) signifigantly,
yet does not add much drag (braking

Turn-Slip Indicator Look at the instrument below the airspeed
indicator. That is the turn-slip indicator. The airplane symbol indicates
the rate of turn (not bank!) and the ball indicates sideslip. Use your
pedals to keep the ball in the center.

Horizontal Situation Indicator Very important navigational
instrument with 2 arrow pointers controlled by the 2 buttons on either
side of the instrument... see the next page for further explanation.

Vertical Velocity Indicator The VVI indicates climb and descent rate
in steps of 100's of feet per minute.

force). As the flaps are FULLY
deployed, however, the lift does not
increase that much more, but the
DRAG goes up a lot. In short, deploy
only a LITTLE flaps to geta LIFT
boost (like for take-off) but deploy
them FULLY to get maximum lift AND
drag (like for landing). Cessnas in
particular have very effective flaps
for steep approaches and low
minimum-flight speeds. It is not
uncommon to have the airspeed
indicator pegged on the lower end of
the dial while in flight in a Cessna
with the flaps down at minium speed.



Navigation Instruments

Let’s talk about how to dial in an ILS. The “Output”
menu has instrument approach charts showing
the ILS and VOR and NDB frequencies for
navigation and instrument landing. To fly an ILS,
enter the appropriate frequencies from the
instrument approach chart for the airport you wish
to land at into the appropriate nav radio and dial
the appropriate runway heading into the OBS. For
the Cessna, the TOP radio frequency goes to the
VOR reciever pictured just to the right, and the
BOTTOM radio frequency goes to the HSI reciever
pictured at the far right.

HSI OBS HSI HDNG VOR-NAV1 TIMER

Horizontal Situation Indicator The horizontal situation

L X o ) At right, we seen an HSI and VOR set to fly an ILS
indicator, or "HSI", is below the artificial horizon. The ant, Y

to runway 09, heading 90 degrees. The HSI and

gyrocompass part of this instrument is obviously your VOR both show us as being right on course. The
heading, but notice the yellow arrow (with line) on this little yellow boxes on either side of the HSI are
instrument. This is the Omni-Bearing Selector (OBS). Itis a centered vertically and the horizontal needle on
course deviation indicator for a VOR or ILS. the VOR is centered vertically, indicating that we

are on the glideslope (the vertical part of the ILS
guidance system).The CDI’s (course deflection

The yellow arrow points to or from the radial that you have indicators, which are vertical lines) are centered

.SEIeCtEd to ﬂy T,he llttle kn"Ob on the Iower-left of the laterally on both instruments, indicating that we
instrument is its "HSI OBS" selector knob. Use that knob to ;4 ight on the localizer (the horizontal part of the
adjust the OBS setting for the direction (radial) to a VOR/ILS s guidance).

beacon with its frequency set in Nav2 (in the radio stack). )
If we wander off to the left of the localizer part of

. . the ILS, the CDI's will drift off the right. If we
e  Click on the left or right part of the OBS selector to wander below the::idesmm part ;?me “:'3 the

decrease / increase the 013S. CDI’s wll drift up above the center. A perfect
ap; roach will have all needles centered for the
. . . . entire approach.
The HSI is hooked up to Nav2 (N2) in the radio stack. This is

the lower of the two navigation radios in the stack. Both receivers above can pick up VORs as well,
which you can use to navigate from place to p|8¢9.

VOR'’s are shown as large circles on the Low
Enroute map.. enter their frequency into whichever
radio you would like to use.

The small orange arrow on the HSI is the heading-select
pointer. This is the heading the autopilot will fly when the
"heading-select" (HDG SEL) button on the autopilot in the
radio stack is pressed.

VOR selector for Nav 1 Radio

This is a standard VOR selector with glideslope indicator
(horizontal line) for the ILS. Note the little round knob on the
VOR gauge. This is the OBS selector for Nav | (see Nav |
radio in radio stack). Remember that the frequency on the
left of the radio stack is used for communications, the

frequency on the right is used for navigation. o b

Rwy 09

Glideslops Radial 210

e Click on the left or right part of an OBS selector to
decrease / increase the 013S.

The localizer is situated several hundred meters
Timer behind the centerline of the runway and indicates

. : the horizontal path to it. The glideslope beacon
_The timer can be started (ST) or cleared_ (CLR) by pressing sits next to the touchdown zone and indicates the
its buttons. It can be used to calculate distances traveled for X :
. . . . . gludeslope or vertical path to the runway.
navigation or keeping track of elapsed time when flying at
full engine power (jets may have a 3 minute limit for this).



Marker Beacon & Audio Selector Panel

Look at the top of the radio stack. The blue, yellow, and white squares are marker beacon indicators. They will
flash when you pass over outer, middle, or inner markers during an ILS approach. The buttons to the right are
the audio selectors. They select what radios go to the speakers, and are only used for the Nav radios and the
ADF in current versions of X-Plane. To hear and test a VOR, dial the VOR frequency into the NAV2 (bottom)
radio, then hit the "NAV2" button in the audio selector panel: you should hear the morse code for the VOR if the
VOR is in range. The same can be done for a Nav | VOR on airplanes that have a VOR for Navl radio instead of
a GPS (global positioning system or satellite navigation), and it can also be used for the ADE

DME

The next instrument down is the distance-measuring equipment. This instrument gives
the distance, speed, and time to a VOR. Like a real DME, this one takes a little while to
give an accurate answer. The two buttons to the right of the display select which Nav
radio you want to get the distance to. NI gets the distance to the VOR selected in the top
Nav radio, N2 gets the distance to the VOR selected in the bottom Nav radio.

Nav and Com Radios

o The next two boxes down are the Nav/Com radios. Com frequencies are on the left, Nav

v A frequencies on the right. Frequencies for Nav | are on top, frequencies for Nav 2 on the
—— bottom. You'll be advised by ATC which frequencies to use for communications (press

Radio stack.  “Enter/Return” key to activate ATC).

e Click on the selector knob to change the frequency

Transponder

The transponder code your plane should send out is given by ATC and must be set in the transponder by turning
the knobs. The code can vary during a flight. After setting ("squawking") the code you can cause your plane to
light up on radar by pressing the ID button. The blinking reply light indicates ATC's radar is tracking you. Set the
transponder to 1200 if you are not talking to ATC.

e  Click on the selector knob to change each digit.

Autopilot
The three buttons under the "HDNG bar" are as follows:

ALT 100C

HDG SEL fly the heading selected by the orange arrow on the HSI. Adjust the The autopliot console In the

orange arrow with a knob on the HSI. glareshield presets the altitude,
vertical speed, and airspeed.
Pressing the ALT SEL, VVI SEL or AS

NAV 1 fly the VORALS selected on Nav | (or GPS module) HLD button on the autopilot will
NAV 2 fly the VORALS selected on Nav 2 (HSI left button) cause the plane to follow the

numbers entered above.
The three buttons under the "ALT bar" are as follows:
ALT HLD hold the altitude selected in the glareshield.
VVIHLD hold the vertical velocity selected in the glareshield.

NAV 2 fly the ILS glideslope selected on Nav 2
Note: a glideslope for the ILS must be available

The button under the "AS bar" is as follows: ADF for NDB beacons
AS HLD auto-throttle to maintain the airspeed selected in the glareshield.



GPS - Global Positioning Satellite System

Open the Glasair-1l in the "Homebuilts" folder. ("File / Open Aircraft" in
X-Plane, then navigate out a level from the "General Aviation / Cessna" folder
over to the "Homebuilt / Glasair" folder). Notice that in the Glasair, a GPS
replaces the Navl radio. The 3 buttons labeled APT, VOR, and NDB select
whether you want to fly to an airport, VOR, or NDB. After making the
appropriate selection, dial the identifiers with the digit and scroll knobs. As
usual, click on the knobs to proceed. Once you have dialed in your destination
you can fly to it using the GPS. You get a CDI (course-deflection indicator; the
dot between the three | lines), which works just like the horizontal deflection on
a VOR to help you fly to your destination. In our above example Lyon
Satolas-France is centered and straight on course.

DIGIT moves the cursor across the GPS-selection display
SCROLL when pressed at top or bottom scrolls up or down
the list or characters and names

ADF - Automatic Direction Finder

Get back in the Cessna to use an ADE The needle of the Automatic Direction
Finder will simply point at whatever radio station the ADF is tuned to. Notice the
three knobs under the ADF indicator. These select the ADF frequency. The
ADF compass rose can be slaved to the compass in Plane-Maker.

e  Click on the upper part of the knob to increase the frequency.

e Click on the lower part to decrease the frequency.

Piston Engine Instruments & Management
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Here is a radio stack withg a GPS, a
NavCom radio that sends data to an
HSI, and retractable gear as well. The
aileron and rudder trim for fine-
tuning the airplane are to the left of
the gear handle.

OK get back in the Glasair again. To move any of the engine controls, use the mouse to drag the handle up or
down, or use the function keys. X-Plane offers carbureted and fuel injected engines. Here are the basic controls:

EGT Exhaust gas temperature, influenced by (red) mixture handle
RPM Engine speed, set by (blue) prop handle
MP Manifold pressure, set by (gray) throttle handle.

Throttle gray handle (T) up is full
Mixture red handle (M), up is full rich
Carb heat little square (C), up is full cold

Flaps (F) pull down handle in 4 stages, up is retracted
Trim (Tr) with arrows on it (right) to trim the plane up/down

NOTE: Aircraft with constant-speed propellers use the throttle to control engine TORQUE (as seen in the
manifold pressure indication), the prop to control RPM (as seen in the RPM indication), and mixture to obtain the
optimum fuel/air ratio (as seen in the Exhaust Gas Temperature, or EGT). Set the mixture so that the EGT is

near maximum. You can practice this in the Glasair.

In the Glasair, take off under normal weather conditions for a test flight. Set flaps to | notch extended. Dial
autopilot altitude 3000 feet in the panel glareshield. Prop full forwards (top position) mixture full rich (top position).
Throttle up and release the brakes. Steer along the runway and lean back on the stick a moment upon reaching
70 knots. Now maintain 100 knots or so and retract the flaps. Press autopilot button ALT SEL. Set the VVI in the
autopilot to 1000 fpm again if needed. Set autopilot to HDNG SEL as well, steering with the little yellow bug on
the HSI. Let the plane climb to 3,000 ft at full power. The autopilot should level the plane at 3,000.



Now reduce the mixture (pull it back) gradually and watch the exhaust-gas temperature. As you lean the mixture,
the engine runs hotter. This is more efficient but could damage some engines. On the other hand, if you keep
flying 'cool’ or 'rich' and land, one finger (briefly!) in the exhaust pipe reveals tarnish and oil, indicating that you
have wasted fuel. The optimum setting is a bit on the rich or knob-up side of maximum exhaust-gas temperature
for most engines.

Variable-Pitch Props typically have a "cruise" setting when en-route. When we climb we want (nearly) all the
pulling power, but en-route we feather the prop a bit to reduce RPM. Bring the prop in the Glasair back to about
2,300 rpm for efficient cruise, and the throttle back to about 23" of manifold pressure for moderate engine power.

Carburetor heat is needed when landing a carbureted plane, or ice may form in the engine air intake and

strangle the engine. A warning will appear in the top "status" bar in X-Plane. If this happens then activate the
carb heat found in the lower right of the Cessna 172 panel.

Modern Jet Instruments

OK open a jet, like the Boeing 777 in the heavy metal folder. Airspeed, Horizon, and Altitude are in the top left
display. Note the yellow squares on either side of the artificial horizon and the little line on top: these are the
glideslope and sideslip indicators, which you know from the HSI and turn/slip indicator in the other planes. The
glideslope is hooked up to whatever instrument landing system (ILS) is tuned in on Nav 2 radio. A red dot
appears on the altitude tape when surface contact is imminent. Flight Mach number is under the speed tape.
Barometric pressure is under the altitude tape.

Horizontal Situation Indicator The horizontal situation display, or "HSI", is below the artificial horizon. It is
the same as the HSI you have already played with in the light planes, but has a digital DME indication on the
lower left.

Vertical Velocity Indicator
The VVl indicates climb or descent in 1,000's of feet per minute.

Altimeter

Note the barometric pressure setting knob on the HSI. Use it to adjust the
altimeter setting. Note that the barometric pressure is preset to 29.92"/1013.2
mbar (hPa), the standard altimeter setting (SAS).

EFIS

The large display to the right is the moving-map portion of the Electronic Flight
Instrumentation System, or EFIS. It shows airports, NAVAIDs, weather, and other
traffic (tiny boxes with numbers indicating the altitude in hundreds of feet above or
below you). Note the gray buttons at the bottom... z- and z+ zoom in and out, the

EFIS with weather and traffic
information activated



range being depicted in the upper-left comer of the display. The "enr" and "arr" buttons are for selecting the
"enroute” or "arrival" modes of the display:

Enroute Mode displays the map oriented with your heading upward. Many pilots like to see the flight direction on
top for easier recognition of airports and NAVAIDs to come. A VFR pilot with a huge map upside down over his
knees knows the benefit of nice EFIS display that can always show your direction as the orientation of the map.
Arrival displays the map with North at the top. This is useful in verifying your approach.

The "WXR" and "TCAS" selectors turn the weather and traffic warning displays on the EFIS on and off.

Heads-Up Displays The HUD, when activated presents data to the windshield for easy viewing. X-Plane offers 2

types of HUDs:
Actual Hoops-style HUD.

1. Hoops HUD, which is a highly experimental concept that draws terrain
and hoops leading up to each runway.

2. HUD with course deviation crosshair coupled to Nav2 in the radio stack,
which is most commonly used in reality.

Select the HUD you want for any given airplane in Plane-Maker. The little
green square that wobbles around is the velocity vector, indicating the true
flight path. The small cross in the middle indicates the direction that the nose
is pointing. The angle between waterline and velocity vector represents the
angle of attack, or angle between the relative wind and the airplane.

. . . HUD’s may give an unjustified
Speed, Heading and Altitude appear along the sides of the HUD. feeling of safety though

Simulated Hoops-HUD HUD with Nav2 crosshair
ECAM Display

Most jets have an ECAM system-providing engine and other aircraft parameters. The ECAM in ENGINE mode
provides the following:

ENG mode BURH BURN  EURH
N1 intake compressor rotor speed in % 2
FF main engine fuel flow in pounds per hour

BURN this indicates that the afterburners are running, which will
tremendously increase fuel consumption!

4
1t
FF

ECAM for jet engine management.

FUEL mode
fuel flow and fuel-on-board indicators

FCON mode
flaps, slats, and other flight control status



HYDR mode:

status of the hydraulic system

FAIL mode:

indication of systems failures

X-Plane offers 3 types of turbine engines:

1. Turboprop engine (typical for prop commuters)
2. Low-Bypass engine (typical for military jets)
3. High-Bypass engine (typical for civil jets)

Control of these engines is somewhat similar to a propeller engine, but the red knob that you are used to using
as a mixture control simply shuts down or starts up a turbine engine, since the engine's computer controls the
fuel/air ratio automatically in a turbine engine. Also for turboprop engines, you get a direct torque indication to
indicate how hard the engine is pulling, rather than a manifold pressure indication like you get in a reciprocating

engine.

JATO

Some airplanes may use Jet-Assisted Take-Off by igniting a solid fuel rocket during take-off. The C 130 military
transport, for example, can use JATO to kick itself into the air rapidly. Hit the “JATO” button on the right side of
the glareshield on so-equipped aircraft to light up the JATO. The X-I and X-15 aircraft in X-Plane use JATO to
simulate their rocket engines, although in fact those aircraft were powered by LIQUID-fuel rockets. Either way,
rocket thrust is rocket thrust (it is thrust that does not vary appreciably with speed or altitude) and the simulation
will fly like the real plane. Put JATOs on any plane in the simulator to see what it is like to get dragged into the air
by a pack of wild horses, which is what a real JATO feels like during actual operation.

Special Instruments & Controls

[ ihrdtid™ Fuel Flow

Special controls are above the
throttle and fuel flow handles. Check
out the variable-sweep B-1 (pictured

below) in the “Heavy metal” folder.

B-1 B bomber with variable-sweep
wings in a medium-sweep position.

Above the throttle and fuel flow console is a panel for special controls. Leftmost sits
the handle for flaps (linked automatically to slats if available), which can be pulled
down from retracted (top position) to maximum in 4 stages. Do not extend the flaps
above We (Velocity Flap Extension). Find the VFE for your plane in the "Viewpoint”
option in the "Standard" menu in Plane-Maker.

Next to this handle is the speedbrake. leave it alone for no deployment, drop the
handle down | for half deployment, or down full for full deployment. Airliners can
have the speedbrake lifted UP | for AUTO-deployment, which will deploy the
speedbrakes automatically on touch-down.

Depending on your type of airplane you may find a handle for either wingsweep or
thrust vector (not both). The B-1 bomber has swept wings, the AV-813 Harrier has
vectored thrust.

Sweeping the wings back allows the airplane to go through Mach 1 with reasonable
efficiency, since the wings do not have to battle supersonic airflow head-on. The
surprise is that it also scoots the center of lift of the airplane back, causing the plane
to act like a lawn dart (always wanting to dive) at low speeds. B-1 pilots do not like
to have the wings swept back below about Mach 0.70 or so, but like to start
sweeping them above that speed.

Thrust-vectoring allows vertical take-off and landing, but an airplane in hover has no

natural stability or gliding ability, so woe to the pilot who loses the atrtificial stability system or has an engine
failure in hover! Set the reliability of these systems in the "Settings" menu.



The trim sits in the right side of the panel and is used to adjust the "resting point" of uni -

the airplane in pitch. For airliners it actually pivots the entire stabilizer, and for us ]

Mooneys it pivots the whole taill The trim, by adjusting the "resting point" of the ™
airplane in pitch, serves to vertically trim the airplane (nose up or down) to relieve v
the arms of the pilot holding the stick and the mechanical controls for the horizontal Thrust vectoring handle as can be

stabilizer or stabilator. This also applies to the rudder and aileron trims to keep the found in the AV-8B harrier.
plane un-crabbed and level respectively.

Radar Altimeter

Some cockpit displays offer a Radar Altimeter. Dial its knob to set the warning
altitude. Height is given in 100's of feet. A value of 200 feet typically leaves enough
room for a go-around.

Braking parachute

Some aircraft use drag-chutes to help slow down on landing. Planes that land fast
as heck (like the F-104 Starfighter) need the drag chute the most. In X-Plane the AV-8B Harrier has thrust vectoring.
button to deploy the drag chute is in the glareshield beside the JATO and anti-ice. The chute can be assigned in
Plane-Maker if desired. The XB-70 Valkyrie and X-3 Stiletto in the "X-Planes" folder in X-Plane have (and badly
need) braking chutes.

Cockpit Instruments

You'll find that different planes have different panels. Some jets may have a digital panel, others a conventional
display.

In Plane-Maker you can change these panels and select specific combinations of instruments.

With graphics editors like PaintShop or PhotoShop you can even create your own panels.

Check out www.xicat.com for all the ways to customize graphics and sound for X-Plane!

NOTE: EFIS shows you other traffic and ATC will try to vector you around it. However, if you fly VFR (visual flight
rules) look for other traffic yourself. A mid-air collision is possible. If you ever get near another plane, try flying
formation on it if you can. Formation flying is fun but very challenging... just try it!

The bar above the instrument panel has several useful buttons varying with the aircraft. Military aircraft can
jettison their load, firefighters can jettison water, some planes may have parachutes for braking, or an arrestor

hook for landing on a carrier. The anti-ice button can help you out in cold weather conditions. Left is the bright
red stall warning light with beeper.
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Jeppesen Sanderson, Inc. provides the professional flight world with up-to-date
maps. You can use these maps to fly X-Plane, but don't use X-Plane maps to fly
for real.

In X-Plane you can fly full instrument approaches, simulate aircraft behavior and
learn the basics of navigation. For non-pilots, if this has aroused your interest for
actual flying, visit your local airport, ask for the nearest flight-school, and go for a
true hands-on experience... you will be allowed to fly the plane under the
instructor's guidance on your first flight!
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Putting the theory to the test
Flight from San Bernardino to Riverside Municipal

1. Click "K S B D" in the "Location / Place aircraft by airport / Airport ID" option. KSBD is the ICAO-code for
your departing airport San Bernardino. In a few seconds you're on runway 06 of San Bernardino, ready for a
short instrument flight to "KRAL", Riverside Municipal airport - situated some 13 miles west-north-west.

2. Load the Glasair from the "File / Open Aircraft” option. It is in the "Homebuilts" folder, as you recall.

3. Press “Enter/Return” and the up-arrow to file your flight plan. Set altitude to 4000 feet and destination to
KRAL. Click IFR (top left). Close your flight plan now by clicking the window close-button, top left.

4. Next use the knobs in the instrument bar below the glareshield to set ALT

Activate ATC Communications in X- :
Plane by pressing Enter/Return key. 4000 feet, VVI 1000 feet per minute.

You may also assign a button on

your joystick to call ATC in the 5. Set NAV I/GPS to the destination VOR (set "KRAL" - read 215'- 13 nm). 6.

Settings:Hardware and Flight llode” — Check the airport map of "Riverside Municipal” in the "Output"” menu.

Once you activate ATC, you will be Note the heading of the landing runway and its ILS frequency. You will go for

able to make selections with the runway 9 with ILS frequency 110.9.
mouse or arrow keys. The

recommended option is always

flashing. 7. Set the HSI needle to 90 (left yellow knob) and NAV2 to the ILS 110.90.

Choose “Say again” to have the last
instruction repeated.

8. Select "Settings / Weights and Fuel" to adjust the weight of your Glasair.
Enter your own weight as the fixed payload, plus the weight of any other people
watching over your shoulder while you fly. Enter 1/2 tanks of fuel.

9. Preflight check: flaps 1 notch; GPS/Navs set; ALT and VVI values set; the
engine at idle.

10. Press Enter/Return and select "Pick-up Flight Plan" Check and write down
the ATC instructions that follow. Set transponder and tower frequency to Com
2.11. Call ATC for take-off permission and note the instructions.

12. Throttle up when cleared, and then release the brakes. At about 70 knots
gently pull the stick to rotate and take-off. At a positive climb press the autopilot
for VVI SEL and climb to the altitude indicated by Air Traffic Control. If climb to
4000 feet is approved, press ALT SEL, and re-enter the VVI selection if needed.

13. Follow the instructions from ATC, change radio frequency C2 to Departure (if advised) and Riverside's
airport. Don't misread ATC. Ask for a "Say again” when in doubt.

14. Follow the heading instructions from ATC using Autopilot Navl to Riverside VOR or by switching to
HDNG/HDG SEL and turning the orange bug in the HSI with the orange (second left) knob under the HSI to the
compass direction ATC has given.

15. You'll be vectored to the ILS of Riverside in a wide curve.

16. At 13 nm DME from Riverside reduce your airspeed to 120 knots, and set 1 notch flaps. Follow the approach
instructions from ATC carefully now.

17. You will be advised to "intercept the localizer for runway 09" - press HDNG NAV2 and ALT NAV2 in the
autopilot. The Glasair will turn to the Riverside ILS, flying the ILS until you disengage the autopilot and land.



18. When you visually see the runway, deselect the autopilot to fly the Glasair gently to the down. Glasair like to
fly their approaches at about 80 to 100 knots with partial or full flaps. Gently raise the nose when close to the
ground to ease out of your descent and touch down. Power off, hit the brakes, and taxi clear of the runway. Hit
enter again to tell the tower that you are clear of the active runway and ready to taxi to the ramp.

Touring the X-Plane Menus

About File Location Settings Output Rlaotes Uiew Special

The File Menu

Open Aircraft
Just select your favorite airplane, provided it is available on the disk, and go fly it! The aircraft file must be in the
"Planes" folder or in the same folder/directory as the simulator itself!

Load/Save Situation
Just set up the airplane any way you want and save the situation. You can load that situation again whenever
you want. Situations are saved in the "Situations" folder in the "additional nav data" folder.

Quit/Exit
Exit the simulator. X-Plane usually remembers the nearest airport when you left the simulator. So it's a good
habit to land your plane first, then quit

The Location Menu

This starts you off wherever you want... You can experiment to see which options you like to use. You can also
get lost, found, go to any airport, try situations like buzzing forest fires, approaching an aircraft carrier, and much
more. Experiment with these options. The B-26 water bomber is good for forest fires, a helicopter is good for
the helipads or frigates, the F-4 Phantom is good for carrier approaches, the Scwiezer 2-32 is good for
glider-towing, and the X-15 should be dropped from a B-52.

This is also where you choose the planet Mars for a special out-of-this-world flight. Be sure to read the chapter
“Flying on Mars” for more information.

The Settings Menu

Data Output Window
There are three places you can send flight data using the "Set Data Output" window:

1. Disk File
The data requested goes to the file "X-Plane.out" in a "black-box" format. You can view the data after the flight
by opening "X-Plane.out" with any word processor.

2. Graphic Display
The data requested goes to a graphical display where it can be accessed by selecting "Graphic Flight Record"
from the "Output" menu. Up to four variable groups may be chosen.

3. Cockpit Display
Data is sent numerically to the windshield, where it is shown in real time. Several variables may be chosen, but
the frame rate will deteriorate if you view too many options.

Data Output Parameter

The left buttons are for disk output to the file "X-Plane.out", the middle are for the graphic display in the output
menu, and the right buttons are for values to go to the cockpit in flight.



Let's walk through the list of output variables:

Frame rate, or cycles per second, of the simulator. About 18 fps. is sufficient for a smooth display. Real Time
Ratio is how close to real time the sim is running. On average 0.99 is a good value. Less than 0.9 is fast motion,
more than 1.1 is slow motion. Local Time / Z-Time is the difference between the actual system time and world
time.

Sigma is the fraction of sea-level air density that exists at the current altitude. Rho is the air density at the
current altitude.

Alpha and Beta are the angles of attack and sideslip, respectively. The angle of attack is simply the angle at
which the airplane strikes the air. Positive angle of attack means the airplane is pointed up with respect to the
airflow (trying to climb) and negative angle of attack means the airplane is pointed down with respect to the
airflow (trying to descend). Horizontal Path is the course over the ground in degrees, 0 is North, 180 is South.
Vertical Path is the climb or descent angle in degrees, positive is climbing, negative descending.

Throttle is the part setting for each engine (0.0 is idle, 1.0 is full throttle).

Prop is the prop control position (blue handle), in RPM. This doesn't necessarily mean the revolutions per minute
the prop is making.

Wing Sweep and Thrust Vector are the wing sweep in degrees and thrust vector in degrees, where 0 is vector
straight back, 90 is straight down.

Stick & Rudder ail/elv/rud are the pitch, yaw, and roll control input that are being received from the joystick and
rudder pedals, where 0.0 is centered and 1.0 is full deflection.

Flight Control all/elv/rud are the amount of pitch, roll, and yaw control deflection that are actually being sent to
the control surfaces, which may be different from the data above if the aircraft has an artificial stability system
and/or the flight control sensitivity is not at 100%.

Trim, Flaps, and Slats indicate the deflections of those surfaces.

Gear, Brake, and Speedbrakes are deployed or not.

Vtrue, Vindicated are the true and indicated airspeeds. Remember that the airspeed indicator tells how fast you
are going by looking at the air pressure, and as you climb the air gets thinner, so the INDICATED airspeed will
be lower than the true airspeed.

Vertical Velocity is in feet per minute.

Mach Number indicates fraction of speed of sound... the simulator loses some realism above about Mach 0.90
due to transonic and supersonic effects.

G-Loading is the number of G's you are currently pulling.

Local Speed of Sound is the speed of sound at your current altitude and temperature.

Dynamic Pressure is the air pressure on the airplane from moving through the air. The faster you go, the
greater the air pressure. This dynamic pressure is converted into lift by the wings, so the dynamic pressure is an
indication of how much lift your airplane can produce at the current airspeed, air density, Mach number and air

temperature.

Angular Moments are the torques on the airplane.



Angular Accelerations are the accelerations in pitch, heading, and roll of the airplane.

Angular Velocities are the pitch, roll, and yaw rates, or the speeds at which the aircraft is rotating.
Pitch, Roll, and Heading are just what you think they are.

Distance traveled is the distance covered (it resets to zero each time you open this window).

Lat, Lon, and Altitude are the latitude, longitude, and altitude of the airplane at the moment. X, Y, and Z are the
location in meters from the southwest corner of the first environment file you opened.

Power is the power output of each engine in horse power.

Thrust is the thrust output of each engine in pounds.

Engine Torque is the torque in foot-pounds that each engine is putting out.

Propeller RPM is the current RPM of the propellers. Prop Pitch is the pitch of the propellers, in degrees.

Propwash speed is the speed of the propwash well behind the propellers. This is added to the aircraft's airspeed
to find the airspeed over parts of the airplane that are in propwash.

Manifold Pressure is the pressure in the intake manifold of each engine, and is used to set power.

N1 is the percentage RPM that the compressor fan is turning on jet engines - the 'intake' pressure.

FF is the fuel flow ratio in pounds per hour.

Aerodynamic Forces are the total forces on the airplane due to aerodynamic loading (i.e. lift, drag, and side
force). Engine Forces are the total forces on the airplane due to the thrusts (or drags!) of the engines. Landing
Gear Deflections are the deflections of the landing gear from their fully-extended positions, in feet (1 feet =

0.3048 meter).

Lift Over Drag Ratio is the ratio of lift of the airplane to drag of the airplane, and is a measure of the efficiency of
the airplane. Look for a value of at least 10 for reasonably efficient flight.

Prop Efficiency is the propulsive efficiency of the propellers. It is simply a measure how efficiently the props are
converting the engine's horsepower into usable thrust. Look for at least 0.85 or so for efficient cruising.

Ailerons control aircraft roll. Deflection in degrees.

Roll Spoilers are on the wings, and spoil lift on the wings to roll the aircraft. Roll spoilers can be used instead of
ailerons. Deflection in degrees.

Elevators are on the canard or horizontal stabilizer and control pitch. Deflection in degrees.
Rudders are on the vertical stabilizer and yaw the airplane. Deflection in degrees.

Yaw-Brakes are speedbrakes on the wing tips that can be deployed left or right to yaw the airplane if no rudders
are available, as is the case with flying wings.

Cyclic and Differential Yaw are helicopter and VTOL rotor blade deflections.

Payload Weights are the weights of fixed payload, fuel, and water in pounds.



Total Weights are the weights of the airplane when empty and the current total weight of the airplane, in pounds.

Serial Output
This screen is here for you to hook up special accessories like a hydraulic cabins, moveable seats, real cockpits,
or moving maps.

Rendering Options Window
This allows you to set the graphics options for the sim. Set to higher color depths and texture resolutions if your
card can handle it, otherwise leave them at the defaults. When in doubt, experiment.

Time of Day Window

Use this to set the time of day for your flights. Dawn (06:00) and Dusk (17:00) are recommended. Evening
(19:00) with an overcast cloud layer is recommended for instrument flight (IFR) training. Time will advance in
real-time.

Joystick Axis Assignment
Assign functions to your joystick axis.

Hardware & Flight Mode
Assign functions to your joystick buttons as well as adjust the realism and sensitivity levels. You can also
choose your keyboard language.

Weather Conditions Window

(Space, Atmosphere, Ground, and Water) Note that you have slider control over the meteorological situation at
various altitudes. These innovative double sliders outline the limits you set for the weather at various altitudes.
The "rate of change" slider controls how fast the weather is changing. The computer's internal weather
generator will keep the weather changing until your limits are reached.

You can also fly in actual real-time weather!
Visit: http:\\www.menet.umn.edu/-curt/weather/x-plane.html Put the "WORLD.rwx" file in the "X-Plane" folder.

Conditions for ground, water and space may also be set. Don't slide on a wet runway, crash into a Tsunami, or
get hit by meteorites!

Flight Mode Window

For technically realistic flying, all the damping should be completely turned off, and the joystick sensitivity
cranked to full. Simulators are harder to fly than real airplanes, though, so you may want to add some atrtificial
damping and lower the joystick sensitivity to make the airplane feel more realistic. If you are flying helicopters,
then it is a good idea to put in some extra damping and reduce the control sensitivity.

Weights and Fuel Window
Use the sliders to set the weights and fuel you want to fly. Watch the maximum !i“'““'“"""“" \\
take-off weight! If you fly over this weight you are asking for trouble. 2

e
Realistic, Instrument and Equipment Reliability Windows

¢ Engine failure will cause immediate lack of power.

e Vacuum system failure is realistic, complete with gyro tumble as the gyros spin
down.

¢ Instrument failures will cause the instruments to stay in the position they were in
when the failure occurred.

e Control failures will cause the controls to snap to the center position and stay there.
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Sound Window
Sounds are set here. ATC verbal communications are possible if the appropriate
speech drivers are installed.




Warnings Window
This sets how "strict" the sim is. All boxes should be checked "on" for maximum realism. Check them "off” if you
want to do free-flight without worrying about aircraft limitations.

Quick Flight Setup
Takes you back to the opening “Quick Flight Setup” screen.

The Output Menu

Graphic Flight Record Window

This is where the graphic data selected from the "Data Output" in the "Settings" menu can be observed. Point
the mouse at whatever part of the curve you are interested in (no need to click) and the numerical value of that
data appears underneath the labels at the left side of the screen. Clicking on the "starting time" controls at the
bottom of the screen controls how many seconds since data selection was made you wish to start viewing.

Low Enroute, Local Virtual-World, Weather Radar Map, 3-D Path, and
Isometric Region Windows

These plot the local area with your flight path plotted in red and black. The
weather radar map shows fine details if you have thunderstorms selected in the
"Set Weather" window. You may position your aircraft in various maps by
setting altitude, speed and direction, then clicking in the map.

Logbook
Setup your own personal real time logbook

Plates Menu

. A h Chart with
Approach Plates for the Local Airports simu.,,.'i’.,“n“:";i.u,, t:_m::.s_

Plots the approach plate of the selected airport. This chart is used for setting
VOR, ILS, and ADF frequencies as well as planning ILS approaches. Notice the elevation of your airport! Fly an
instrument approach and then open these windows to see how your approach looked.

Planet Map
Place your aircraft according to a map view.

The View Menu

Views
Several view options are available for watching your flight. The letters in brackets are keyboard equivalents. Just
hit those keys to get the views. On some European Macintosh keyboards the "I" is “Option+7".

Enter / Leave Flight Replay Mode offers a video replay of your flight. In the glareshield some recorder like
buttons appear, which can be ' pressed to wind up or down, start or stop the replay, or study interesting

situations (like crashes). If your monitor or video card has video out you can output the movie to a video recorder.
You can change the view of the replay with the usual keys from the "View" menu.

The Special Menu

Output one flight engine cycle

This saves an extended text file to disk with all current simulator data. You can read this file with any word
processor. This option is useful for people with an aeronautical engineering background, or the extremely curious.
Use this data to check the simulator output, or observe loads or other data pertaining to the aircraft at the
moment that you clicked on this menu item.



Reset Prefs and Exit

In the unusual case that X-Plane starts behaving in a fashion that you can't recover from (i.e. it keeps crashing
the airplane or something weird like that), you can select this menu item to reset the simulator to it's original

factory settings.

Instructions Windows

These are brief but self-explanatory. X-Plane uses help-screens when you leave the mouse-pointer over an

unclear subject for a few seconds.

About Helicopters

Go to the "Hardware & Flight Mode" option in the "Settings" menu and set the control sensitivity down a bit.
Put in some extra damping. This is just to smooth things out for your first practice. You can make things more
realistic later. Now open the Special Ops Blackhawk for your first flights. This is a big heavy helo that has a nice

solid feel.

A helicopter is in fact a marginally stable flying machine. The main rotor produces somewhat more lift than the

weight of the helo, allowing the machine to take off vertically.

To pitch or roll the helicopter the main rotor blades
change pitch as they move around the rotor disc. This
causes the rotor to put out more thrust on one side
than the other, causing the helicopter to pitch or roll.
This change in rotor blade pitch is referred to as cyclic
pitch.

The cyclic pitch is controlled by the "cyclic" stick,
which is the main control for the helicopter and is
equivalent to the stick or yoke of an airplane. To climb
or descend, a helo increases or decreases the pitch of the rotor blades overall, not
just when the blades are at one part of their path around the disc. This "overall"
change in pitch is referred to as "collective pitch".

This "collective" is physically set up like a side-mounted parking brake in a car: you
pull it up to go up, you push it down to go down. The collective is somewhat
analogous to the throttle in an airplane. But who controls the actual throttle? A
computer!

The helo cockpit is smaller than that
of airplanes. There is a piece of yarn
tied to the base of the windshield that
serves as a sideslip indicator. The
throttle handle serves here as

collective pitch grip and should be
upward to keep the helo on the
ground. Gently drag it down to take-
off and learn to hover at low altitudes
first. Watch your flight with the replay
option in the ‘View’ menu.

The computer in a real helicopter automatically manipulates the throttle to maintain operational RPM. There is a

Distribution
of lift

T
Cyclic pitch
at this point

irection

Cyclic pitch [ v )
here now ! Tailrotor
smaller

— rotor turning at the right speed.

catch though: If you force the rotor to a very high collective
pitch by pulling up on the collective too much, then the

of rotor larger ~engine might not have enough power to keep a constant

(more lift)

rotor speed, even at full throttle! RPM will drop and you are in
a rotor-underspeed situation that must be remedied! The
cure is simple: lower the collective stick enough that the pitch
on the blade lowers to the point that the engine can keep the

The pitch of the main rotor can vary Thrust-Master or CH-Products throttle quadrants act like the collective when

with its position around the disc
during a single revolution. This cyclic

you are flying helos in X-Plane. Throttle full forward is full flat (DOWN),

pitch pitches and rolls the machine. collective. Ease the throttle back towards you to INCREASE the collective.
Changine the pitch of the blades The throttle handle is acting like a collective pitch grip in the helo, and the
overall causes the machine to climb  computer is actually controlling the engine throttle to maintain the correct

or descend. The tail rotor cancels out
the torque of the main rotor.

RPM, which should stay the same for the entire flight.



Your rudder pedals, if you have them, act as anti-torque pedals, which simply increase or decrease the pitch
on the tail rotor to yaw the helicopter left or right and counteract the torque of the engine.

A well-designed helicopter should hover with the tail rotor, main rotor, and rotor cant all canceling each other out
nicely so that the machine hovers at moderate power with almost no deflection of the controls.

About Aircraft Carriers

Landing on an aircraft carrier seems tricky at first, but gets easier with practice. Head on over to a coastal airport
like LAX, get in an F-4 Phantom, and ask for a carrier approach or catshot in the "Location"” menu. The F-4 is
one of the hardest airplanes to fly, so you might try getting an A-4, A-6, F-18, or some other plane from
www.xicat.com to test your mettle at first. If the weather is good you can fly your approach visually, otherwise
tune an ILS to 108.00 to pick up your ILS signal to the carrier... real carriers use somewhat different frequencies

and ILS equipment, but the general result is the same. _

At any rate, get set up on or near the carrier in the "Location" menu or
navigate to the carrier using the "Local Virtual World" by looking for a
little square with a "C" in the middle.

For a cat-shot you are placed on one of the catapults. Throttle up and
release the brakes to be shot off the deck. For a carrier approach you
are aligned with the glideslope. Don't forget hook and gear down! You
might also (quickly!) get full flaps down and reduce your weight
somewhat by jettisoning your load. Carrier approaches are almost
always made at minimal weight.

At about | mile out you will see the Fresnel lens (or "meatball") on the
deck just to the left of the wires. It has a row of green lights with a yellow
light in the middle. The Airboss will inform you when to "call the ball" (you
need not respond in the sim). You now fly an approach path that keeps
the meatball centered. The voice of the Landing Signal Officer warns you
of errors in speed, attitude and heading. If the Landing Signal Officer is
not happy with your approach he will shout "wave off” at you. Go around
and try again. After landing you may select the "carrier cat shot" again or
taxi to the left-front catapult to be automatically hooked up for another
shot.

The visual glideslope indicator with "meatball” indicates the following:

e If the center light is above the row of green lights, you are high.

e Ifthe center light is below the green lights, you are low or swimming...

e Ifthe center light is right in the middle, between the green lights, you're on glideslope like you should be.

The trick to the carrier landing is:

¢ Keeping the plane aligned laterally with the extended centerline of the deck. (Do this with heading, of
course)

e Keeping the airspeed low enough that the nose is aimed a bit up from the horizontal, at a nice positive angle
of attack. (Do this with pitch)

e Keeping the velocity vector of the HUD pointed right at the touchdown zone on the deck. (Do this with pitch
and throttle)

e Keeping the meatball centered. (Do this with throttle)



¢ Keeping all the parameters centered until you crash into the deck. There is no technique to landing on a
carrier other than keeping these parameters perfectly centered until you impact the deck and let the arresting
gear take care of the rest.

About Trans-Atmospheric flight

The NASP "X-30" is to be the next generation of orbital delivery vehicle. It will take off with jet engines, then
switch to rocket engines at high altitude where the jet engines quit putting out any thrust. The rocket engines will
take the plane into orbit, where payload can be deployed. Then a re-entry into the atmosphere follows, the jet
engines fire up again, and a normal landing can be made.

Flying the NASP takes practice, but this will get you started. Open up the NASP in the "Mega-Planes" folder and
fill it up with fuel ("Settings” “Weights and Fuel). Go to LAX or some other huge runway and blast off in full
afterburner. Throttle back to 100% no burner and climb to 30,000 feet or so. Hit the burner again when the
engine thrust starts feeling sort of weak. At about 45,000 feet, or as far as you can climb with the engines, shut
them down. (Yank the red fuel levers back). Hit the JATO (Jet-Assisted Take-Off) button to simulate the rocket
engines that will punch you into space. The JATO is simply a solid-fuel rocket motor. The real NASP will use
liquid fuel, but that is a technicality.

During the rocket assisted climb, gradually level the nose so that the artificial horizon is horizontal at about the
time you reach 300,000 feet. X-Plane's atmosphere goes up to about 250,000 feet, so you will be "in space" at
300,000 feet. If you climb into space at 45 degrees upside down, you will never get a decent re-entry, so
gradually level the nose as to level out at 300,000 feet. Watch the artificial horizon carefully. You must level off in
the top of a gentle curve at a reasonable altitude to have a chance of making a survivable re-entry.

At this moment, your indicated airspeed will be zero, but of course this is because there is no air to push against
the Pitot tube. Your actual speed is extreme, and can be output from the data output window. 18,000 mph is
orbital velocity. You will have noticed during the climb that the indicated airspeed was going down as you entered
thinner air and the airspeed indicator encountered less air pressure, but the true airspeed was always increasing.

Once in space, keep the space-bird pointed straight ahead until the rocket bums out. Use stick and rudder to
always keep the nose pointed right at the flight path velocity vector (the small green moving box) on the HUD.
This keeps the nose pointed in the direction you are going. You will need this during re-entry! Once your rocket
bums out (4 minutes is up, you can't climb further and your engine thrust from the "Data Output" window is 0) it
is time for the re-entry. Hit the "Jettison" button in the glareshield to jettison the satellite you just carried into orbit.
Ease the plane into the atmosphere at a shallow angle! Don't go diving straight down at the planet or you will
break and bum up like a meteorite for sure! The Space Shuttle skips along in the upper atmosphere to gradually
bleed off airspeed, and you must do the same. 18,000 miles per hour at sea level would tear any aircraft ever
made apart in a micro-second! While you keep the nose up a bit and skip across, gradually descending down

into the atmosphere and decelerating, look for an airport on your EFIS display and fly to it for landing.

CHAPTER 2
FLYING THE
SPACE SHUTTLE

The Concept
What do you think the first rule of flying a glider is?

"Never come up short".

When you are bringing a powered plane in for landing, if
you think you are not quite going to make it to the runway,




it is no big deal; just add a bit of power to cover the extra distance! Need a little more speed maybe? Again, no
problem; just add power.

Gliders play be a different set of rules, though. There is no engine to provide power, so when setting up your
landing, you must always have enough altitude and speed to be able to coast to the airport, because if you guess
low by even one foot, you will hit the ground short of the runway, crashing. You can never be low on speed or
altitude, because if you ever are, you have no way of getting it back. A crash is assured. (The exception is
thermals, or rising currents of air, which can give efficient gliders enough boost to get the job done, but thermals
will typically provide less than 500 feet per minute of vertical speed... not enough to even keep a lightweight
Cessna in the air!)

Now with the Space Shulttle, it is certainly true beyond doubt that it has engines. Three liquid-fuel rockets putting
out 165,000 pounds of thrust each, to be exact. To put this in to perspective, a fully loaded Boeing 737 tips the
scales around 130,000 pounds or so. So each engine of the orbiter could punch the Boeing straight up
indefinitely, and that’s not even considering the solid rocket boosters attached to the Shuttle's fuel tank that
provide millions of pound of thrust!

This safely establishes the Space Shuttle has engines.

The problem is FUEL. The orbiter exhausts everything it's got getting up into orbit, and there is nothing left for the
trip down: Thus the ship is a glider all the way from orbit to touch down on Earth. With the final bit of fuel that was
left after the mission, the orbiter fires it's smaller de-orbit engines to slow it down to a bit over 15,000 miles per
hour (Can you imagine... SLOWING DOWN TO A BIT OVER 15,000 MILES PER HOUR) and begins it's descent
into the atmosphere.

Now we have to remember the cardinal rule of gliding: always aim long (past your landing point, not short),
because if you ever aim short you are dead since you can never make up lost speed or altitude with no engines.
Aim long since you can always dissipate the extra speed and altitude with turns or speedbrakes if you wind up
being too high, but you are toast if you come up short.

Following this rule, the orbiter intentionally flies it's glide from orbit extra high to be on the safe side.
But there is one problem. If the orbiter flies its entire approach too high, won't it glide right past Edwards?
Nope.

And here is why. For most of the re-entry, the shuttle flies with the nose wwwaayyy up for EXTRA drag, and
making steep turns to intentionally dissipate the extra energy. The nose-up attitude and steep turns are very
inefficient, causing the Shuttle to slow down and come down to earth in a steeper glide-angle... and if it ever
looks like the orbiter might not quite be able to make it to the landing zone, they simply lower the nose to be
more efficient and quit flying the steep turns... the orbiter then glides better, and they stretch the glide to Edwards
for sure. The extra speed and altitude is the ace up their sleeve, but the drawback is they have to constantly
bleed the energy off through steep turns to keep from overshooting the field!!!

The Walk Through
OK, so let’s walk you through the re-entry process from the beginning, as it is done in the real Shuttle, and all of
this carries over perfectly to the Shuttle landing in X-Plane, which you will fly after reading this chapter.

After de-orbit burn, the shuttle heads for the atmosphere at 400,000 feet, 15,000 miles per hour, and 5,300 miles
away from Edwards. (Yes, you are landing in the Mojave Desert and you are starting your landing approach
West of Hawaii). Not a bad pattern entry, huh? In reality, the autopilot flies the entire 30-minute re-entry, and the
astronauts do not take over the controls of the Shuttle until the final 2 minutes of the glide. The astronauts
COULD fly the entire re-entry by hand, but it is officially discouraged by NASA. It is something about the
gruesome death of hurling through the upper atmosphere on fire if the pilot messes up.



In the history of Shuttle missions (the 100th mission has just come to a close as this is written), the real Space
Shuttle has been hand-flown for the entire re-entry only ONCE, by an ex-marine pilot, as the story goes, who
was ready for the ultimate risk and challenge.

Oh yes, did we mention that YOU will be hand-flying the entire mission in X-Plane, as well?

So you start in X-Plane around 400,000+ feet, in space, coming down to eat air like a bag of bricks at Mach-20.
Your control will be limited in space, but once the Shuttle hits Earth’s atmosphere, there will be some air for the
flight controls to get a grip on and you will actually start to be able to fly the thing.

You will first hit air at about 400,000 feet, but it will be so thin it will have almost no effect at all. Your airspeed
indicator will read around ZERO. Kind of odd since you are actually doing over 15,000 miles per hour, huh? Not
really. The airspeed indicator works just like the wings of the orbiter: based on how much air is hitting it! And in
space, that ain't much!

It will build gradually as you descend. The odd thing is that even though you are actually slowing down, the
airspeed indicator will rise as you descend into thicker air that puts more pressure on the airspeed indicator! You
like this, though, since the air is also putting more pressure on the wings, so the airspeed indicator is really
measuring how much force the wings can put out for you, which is really what you are interested in. (Word to the
wise: If the airspeed indicator is putting out more than about 250 knots, your wings can have plenty of lift to carry
you. If the airspeed indicator is indicating less than about 250 knots, then the wings do not have enough air
hitting them to lift you, and you are still more or less coasting in the thin upper atmosphere where the air is too
thin to do much for you.)

So as the airspeed indicator on the HUD
gradually starts to indicate a value, you know it
means you are starting to ease down into the
atmosphere at 15,000 mph like a sunburned guy
trying to ease into a boiling-hot Jacuzzi...
carefully and slowly. Remember, if you were
going 15,000 mph in the thick air of sea level,
you would break up into a million tiny pieces in a
microsecond... the only reason you can survive
15,000 mph up here is the air is so thin it has
almost no impact on the ship. (And again, the
airspeed indicator tells you how much the air is
really impacting the Orbiter... 250 is a
"comfortable” amount). The trick is for you to be
going a lot slower than 15,000 mph by the time
you get down to the thick air of sea level. And be
at Edwards. And that is what the re-entry is for...
disspating speed as you descend so that you are
never going too fast for the thickness of the air that you are in. You only descend into the thicker air once you
have lost some speed in the thinner air up higher. The whole thing is a smooth process where you never ram the
ship into thick heavy air at too high a speed.

Entering Earth’s Atmosphere

Now as you begin to feel the out tinges of the earth's atmosphere, you will notice a slight ability to fly the ship as
you get some air over the wings and speed on the HUD. Now look at the picture of the orbiter on the right-hand
EFIS display... the Atlantis already has this display retrofitted over its old steam gauges (The EFIS's from the
Atlantis are modeled very accurately in X-Plane. Astronauts could use it for familiarization for sure). You see
yourself and the path down to Edwards. Your goal is to stay on the center path. If you get above it, you are too
fast or too high. You might overshoot! If you get below it, you are too slow or too low. You might not make it! You
must stay right on the center green line. The green line represents the desired speed for the early part of the re-
entry, the desired total energy for the middle part of the re-entry, and the altitude for the final phase of the re-



entry. Don't blame us, that is the way NASA set it up. If you are too fast or high (above the center line) then it is
time to dissipate some energy. Put the thing in a steep bank, pull that nose up and hang on!

The REAL orbiter will be about 30 degrees nose up, in a 70 degree bank to try to lose energy, going 14,000 mph,
glowing red hot, hurtling through the upper atmosphere on autopilot leaving a 10-mile long trail of ionized gas
behind it while the astronauts just watch.

So how was YOUR day?

Anyway, you will do steep turns to dissipate energy as needed to keep the orbiter from going above the center
green line. Look at the little blue pointer on the far left-hand side of that right-hand display. That indicates how
high the nose is supposed to be. The green pointer is where the nose is now. Get that nose up. The pointers just
to the right indicate the desired and current deceleration... you will not fly those, though. Look at the little pointer
up top on the horizontal scale. That is the computer's estimation of how much bank angle you probably need to
stay on the center green line. Follow the computer's recommendation or your own intuition for how much bank to
fly, but keep that nose up for sure to keep you in the upper atmosphere and fly steep banks to dissipate the extra
speed and altitude. You might be tempted to just push the nose down if you are high. Don't. You will drop down
into the thick air and come to an abrupt stop from the tremendous drag, and then you will never make it to
Edwards. You will wind up swimming in the Pacific for sure.

Now, as you make your steep turns, you will be pulled gradually off course. Switch your turn direction from time
to time to stay on course... turn left a while, then right, then back to the left again. That is what they do in the real
Orbiter... you are slalom skiing through the upper atmosphere at Mach-20. Not too shabby.

Watch Edwards in your center EFIS display. You want to go there. Hit the "@" key to see yourself on a flyby.
Fast enough for you? Hit the "W" key to get back in the cockpit.

The Home Stretch

As you approach Edwards, right on your center green line on the right-hand display, you will notice there is sort
of a circle or something out past Edwards. This is your Heading Alignment Cylinder, or H.A.C. You will fly PAST
Edwards at about 80,000 feet or so, fly around the outside of the H.A.C. like you are running around a dining
room table or something, and then after you come around you will be pointed right at Edwards. And if you are on
the green line still, your altitude will be just right for landing as well. This is usually where they turn off the
autopilot and hand-fly the real Shuttle.

Now you are doing about 250 or 300 knots, coming down at about 15,000 feet per minute or so... about 125
miles per hour of descent rate. Do we really need to tell you what will happen if you hit the ground with that 125
miles per hour descent rate? Do not aim for the runway or you will wind up smeared along it in a thin buttery
paste. Aim for the flashing glide slope lights 2 miles short of the runway that we (and NASA) have thoughtfully
provided for you. If they are all red, you are too low. (Oops) If they are all white, you are too high (Hit your
speedbrakes, key "6" or use the mouse). If the lights are half red and half white, you are right on your glide slope.
(About 20 degrees... airliners fly their approach at 125 knots, 3 degrees descent angle.. we use 250 knots, 20
degrees descent angle... not too unusual when you consider pattern-entry started West of Hawaii, actually).

OK so you are at 250 knots, on the green line, lined up with the runway, looking at half red, half white glide slope
lights with the flashing strobes by them. Hold that approach configuration until you are pretty close to the ground
(3-degree glide slope to the runway), then level the descent and get your gear down. ("g"-key or mouse) Get the
nose up for a flare as you approach, and touch down smoothly. Now lower the nose. Now hit the parachute and
even the brakes if you want and let it roll out.

Now do it 100 times in a row without a single hitch and you are as good as NASA.



CHAPTER 3
FLYING ON MARS

About Flight on Mars

First of all, the atmosphere is one percent as thick on Mars as it is on earth. Indicated airspeed is proportional to
the square root of the air density, so the indicated airspeed is one-tenth the true airspeed. The result? If you take
off with 60 knots on the airspeed indicator, your real speed is six hundred knots! (About Mach 1)

While there is almost no air for you, you do have the advantage (sort of) of only about one third the gravity, so it
is three times easier to get airborne! Result? A take-off in a well-designed aircraft can occur at a "mere" 400
knots or so, indicating all of 40 knots on the airspeed indicator!

Sound easy? It isn't, because while your gravity (weight) is only one-third of earths, your inertia is still there in full
force! So you are flying with only 1/3 the total lift of what you are used to having to stay in the air, which seems
fine until it comes time to try to turn or flare. Then you see that while the lift for staying airborne is only 1/3 of
Earth's, the inertia, and thus the lift needed to change direction (this includes the landing flare!) is still there in full
force!

The problem is you don't have that kind of lift, since the air is so thin!
Crashes are interesting on Mars. No air drag to slow the tumbling planes down, and little gravity to drag them to
a stop against the ground!

Crashes look like "the Agony of Defeat" from the Olympics where the guy on the downhill ski-jump bites it near
the top of the ramp and tumbles on and on and on, powerless to stop an accident that started hundreds of yards
earlier! Though on mars, at 400 mph, your plane will tumble across the plains for miles!

Bottom line:

All airplanes on mars are airborne Titanics: Ripping blissfully along, unaware of their impending doom due to
their inability to turn against their tremendous inertia.

Cruising along over mars is spectacular, with the scary red-orange Martian sky, new Martian rocky-red terrain
textures, and visibly thinner air. Due to modified lighting in OpenGL, modified fog in OpenGL, and visibility of
stars, you really can tell you are halfway between air and space! Returning to Earth, you feel like you are flying in
soupy water! Yuk!

What Can You Fly

So what sort of planes can fly on Mars? Not anything from Earth, that's for sure. Not enough lift or thrust. A
Cessna or Boeing will just sit there on the ground without even moving. Put them in the air and they drop like
beveled bricks with no wings.

Both of the Mars-plane concepts in X-Plane are much like the U-2 Spy plane (designed to operate at around
100,000 ft, in similar density air). One with a huge high-bypass jet engine built around the fuselage, and another
with a smaller rocket engine in the tail, like the X-15. The rocket plane has a lower-thrust engine, with plenty of
fuel, for about 30 minutes of flight or so... the jet plane can fly for hours!

These designs are realistic (again, based on the U-2, with reduced weight for the lower structural needs (lower
gravity) and modern (composite) materials). The rocket-plane is pretty much guaranteed feasible (known
technology across the board) but the jet-powered one is unsure since Mars has so little oxygen in the
atmosphere it may be impossible to keep a turbofan engine running. (The Mars jet-plane has twice the average
fuel-consumption, though, to simulate injection of liquid oxygen or nitrous oxide). The jet plane needs a JATO to
take off!



How Do You Stop
Parachute? Nope! 400 mph is only 40 mph worth of drag due to the thin air. You will run off the end of the
runway going 100 mph with the chute only "seeing" 10 mph: Useless for slowing down

Brakes? Nope! You only have one-third gravity, so only 1/3 of your weight on the wheels. No traction!

Reverse thrust? Nope! With only 1% atmosphere, jet or prop engines can put out basically no thrust. There is
just barely enough to keep the airplane in flight at mach-0.85.

So how do you stop? We finally went with an arresting gear. Landings are impossible without an arresting gear.
If you can work the flare out right (it is possible with advance planning) then you will touch down doing about 400
mph.

Bottom line, it is possible to build and fly a piloted plane on Mars, though we used a 10,000 ft runway with
arresting wires, and now you will know what it would be like too.

Of course, none of this is currently on Mars today. Or is it?

CHAPTER 4
WORLD MAKER EXPLAINED

Touring World-Maker

Be honest! You wanted to land in your own backyard or maybe you were looking for the beautiful vistas of the
Spanish planes, the Eiffel tower in Paris, the White House in Washington, or the Kremlin in Moscow.
World-Maker is an editing tool for the ".env" scenery files that allows you to do these things and more.

The scenery data for X-Plane was created by an adaptive-gridding program that uses world-wide elevation maps.
This approach offers the great advantage of providing world-wide elevation. However, the disadvantage of this
method is that it doesn't offer "custom-crafted” maps and is not aware of exact coastline locations. While the
elevation data is good, some lakes, rivers and other (smaller) details may be left out, and some low areas may
be portrayed blue and "under water".

Here is where World-Maker comes into play. It is a tool to iron out coastlines, lakes, rivers, and complete
scenery files with obstacles and textures of your choice.

Three components are responsible for X-Plane's world: the files "nav.dat" and "apt.dat" and a multitude of
".env" (environment) files plotting the landscape of most parts of the world.

The "navdat" file contains all NAVAIDs for X-Plane, The "apt.dat" file contains all the airports. The ".env"
(environment) files contain all the objects and terrain, thus creating the X-Plane virtual world. You may notice by
looking in your "additional nav data" folder and "data" folder on the X-Plane CD that almost all the “.env” files
are on the CD where they cannot be modified. This will never do at all' You need to get scenery to your
"additional nav data" folder where you can modify it with World-Maker.

Exploring Latitudes, Longitudes and env Files

To edit a scenery file to create or adjust obstacles, change the height of mountains or fix a lake or river, the
correct ".env" (environment) file must be in the "additional nav data" folder. First look in the "data" folder on
your X-Plane CD. Each ".env" file is named based on the latitude and longitude of the data in it. A file named
"+010-160", contains scenery data with its lower left corner at a latitude of +0100 and longitude -160'".



Recall: Latitude or "parallels" are imaginary lines running east-west, whereas
longitude or "meridians” run north-south. Both divide the Earth into degrees.
Each degree is divided into 60 minutes and the minutes are divided into 60
seconds. The location of Washington D.C. is given by the crossing of latitude
and longitude: 'lat' 039'00'00" North and 'lon' 077'00'00" West. Latitudes to the
North of the equator are positive values. Longitudes East of the 0' meridian
(over Greenwich, UK) are given in positive values.

Each ".env" rile is marked by its name which is the lat and lon of the lower left
(south-west) corner of the covered area. So, if you want to edit the +025 -120
area you should put the corresponding env folder ("+020-120", with all of it's
".env" files) in the "additional nav data" folder on your hard drive.

-052-040 =052+040
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Each ".env" file covers one square degree of latitude and longitude. Each tz:;”;;‘is:g:;:]‘:,‘f&‘g:fds are
FOLDER covers an area that is 10 degrees latitude by 10 degrees longitude, mapping.
so a folder can contain up to 100 env files. (No env files are required for empty
ocean). For X-Plane to find ".env" files, the “.env" files must be in a correctly-named folder, which you see in the
"data" folder on your X-Plane CD... we recommend that you simply copy whole folders-full of ".env" files from the
CD to the "additional nav data" folder for editing... that will save you from having to create and properly name
folders. The ".env" files in the "additional nav data" folder will OVERRIDE the files on the CD, so you can edit
your own scenery for flight in X-Plane.

When you open World-Maker you will see at the top left the latitude and longitude of the present ".env" file.
Scroll around to find the area you want to edit. If nothing is present but a dark blue grid, then the files for the area
in question are simply not present in your "additional nav data" folder, or they are in folders that are not properly
named.

Remember, once you copy the ".env" files from the CD to the hard drive, Windows will think they are read only
since they came from a CD. You will have to change them to NOT read only in Windows by right-clicking on
each file you want to edit and then selecting the “Properties”. In the “Attributes:” section of the Properties menu,
click on the “check mark” next to the “Read Only” option. Macintoshes can figure these details out for
themselves.

Terrain in World-Maker
World-Maker has four editing modes: Terrain, Obstacle, Airport, and NAVAID. Select the
modes in the "Edit" menu. Use Terrain editing mode to adjust coastlines, elevations, rivers,
etc.

Now suppose you want to adjust the scenery of ".env" file "+034119". Simply press the "lat"

and "lon" buttons to get to the right environment file after copying that region from the CD to
the "additional nav data" folder. Lat and lon can have either positive or negative values, so

you can reach any region.

The displayed ".env" file shows the geographical properties of the map, like hills and lakes in
various green or blue shades, yellow parallel lines showing runways and various obstacles.

The geographical properties are modifiable with the "Terrain" option in the "Edit' menu. The
obstacles (buildings, towers etc.) are modifiable with the "Obstacles" option in the "Edit"
menu. Both information on geographical properties and obstacles are saved in the relevant
".env" file, while airports and NAVAIDs are saved in the 11lapt.dat" and "navdat" files.

To modify the geographical properties you can move nodes and change their altitudes or
toggle water on and off by clicking in a quadrilateral field with the mouse. A quadrilateral is a




tiny building block within the ".env" file that you can see when zooming in on the map. You can also see the map
with its textures by pressing the “Spacebar”. Zoom in and out with the “+ / -“ keys. Move around with the “Arrow”
keys.

Objects in World-Maker

The FAA lists over 30,000 obstructions to air navigation (obstacles) and X-Plane has them all,
but most of these are represented in X-Plane simply as generic-looking buildings. These
obstacles that come with X-Plane include buildings, radio towers, power lines, cooling towers,
and smokestacks. You can easily modify their height and heading, or add new obstacles.
Simply get World-Maker into "Obstacle" mode in the "Edit" menu and select your choice from
the left-hand side of the screen. You may delete, move, add, or edit the various objects.

Press “M” (see the "Special" menu) to cycle through these options. While the default

change

[ change neight ===

obstacles are functional from an aviation point of view, they are not very exciting to look at | feustomy D
since they are simply generic towers, smokestacks, and a few generic building types. This =TT
being the case, you may want to customize certain buildings so that they really look just like |

their real-world counterparts. Examples of buildings that you may want to look just like their inhe chsriv b

{folder in the ADDTIONAL

real-world counterparts may include the World Trade Centers, the Sears Tower, the Statue of SR Lulder,
Liberty, or your house. This is easy to do using CUSTOM OBJECTS in X-Plane. Here's how:

Custom Objects in X-Plane are 3-dimensional structures that are defined by x,z,y-points
and have textures on them in 24-bit BMP-format. Read "World-Maker A quick custom object example:

Instructions.txt" in your "X-System" folder to see a description of the current format, L L AN e )
and how to add your own custom obstacles. The basic idea, though, is that you create |34 5% Vaactor startpoiet
a text file in the word processor of your choice that contains the geometry of the A0S fHmre
custom object, and lists what textures you want to be used on that object. 202 #Y=miinheight from 0

4 grassmarker.bmp # its 2. side »cow |

. . . 511

Note: The surfaces of the custom objects must be designated clockwise as seen from |21 ﬁ
the outside: top left - top right -bottom right - bottom left. 504

9970 DENOTE THE END OF FILE!
Note: When you are done creating the objects in your favorite word processor, be 14 object s aquare, 3= risngle.
sure to save them, and their textures, in the "Custom Objects" folder inside the 2= Me nd 1.~ polnt b RGB . 24)

"additional nav data" folder. SAVE THAM AS ASCII TEXT FILES!

After you have created and saved your custom objects, get World-Maker into "Obstacle"” mode from the "Edit"
menu, and then choose "add custom" and click on the desired location to place your custom obstacle. A small
cross will appear. Click in the "change name" box to open the custom object file that you created and saved
(with a word processor) in the "custom objects" folder.

Airports in World-Maker

To create or edit airports with World-Maker, go to "Edit / Airports" in
World-Maker, or open the file "apt.dat" with a word processor. Each airport in
X-Plane CLASSIC may have up to 3 runways. X-Plane 5x offers unlimited
runways, though, and a variety of runway surfaces like asphalt, concrete, gravel,
dirt, and grass are available. Runways have approach-light options, such as
glideslope indications, approach lights leading up to the runway, and the runway
lights themselves.

To create or edit airports with a word processor, see the "World-Maker
Instructions.txt" file in your X-System folder. If you ever make any modifications
to the "apt.dat" file with a word processor, be sure to save those changes as
ASCII TEXT!

Runway surface may be asphait,
concrete, grass, dirt, or gravel.



The World-Maker instructions in your X-System folder have more complete info, but here is a quick example from
"apt.dat" for X-Plane 5x, which you can edit with any word-processor:

Various runway lights are available A Apple file, may be | for files created on IBM's

as follows: 500 version#

(A) Glideslope lights: | object is airport, then elevation
none 01 no control tower but standard buildings
vast CzZ  airport ID and name
pap 10 facility type/runway

(B) Runway lights: lat and lon of center of runway, runway number, L or R or G or none, heading,
:1':::8 length, width, surface code + lighting systems
reil
rels Textures in World-Maker

(C) Approach lights: X-Plane uses default, generic textures for water, grass,
none mountain, snow, and the borders between them.
::::; X-Plane automatically applies the borders between
alstl these textures. All of these default textures are found in
aI:flz the "textures" folder inside your "X-System" folder.
odals

They are simply 256x256 pixel bitmaps in 24-bit color.

In many cases, though, you may want to customize these textures to ones that are
more appropriate for any given area. Perhaps you want city, desert, or harbor
textures. These can easily be created and added. If required you can assign up to 20
different custom textures for each ".env" file. To do this, simply create a custom
texture (for example desert) in PaintShop, PhotoShop, or any other program you like.
Once you have created the custom texture that you want to see in the sim, save it as
a 24-bit bitmap in the "custom textures" folder inside your "additional nav data"
folder. Now launch World-Maker and drop it into terrain editing mode with the "Edit"
menu and add the custom textures that you just created by using the toolbar on the
left side of the screen.

A demonstration of the effects of
When creating custom objects and textures, remember that fine lines will cause "jitter" ~ **"***'**“"**
and resulting eye-fatigue! The same applies for high-contrast textures, or too many
colors. Many simulators manifest such line-jitter and interference by having textures
with too high a contrast. A smart combination of minimally varying greens and grays
(steps of max. 3-5%) will do for a landscape, provided the pattern does not repeat
itself. Houses can be simulated by rectangular dark grayish shapes with a black 2
pixel wide border (shadow) at one side. Seamless welding of any BMPs is achieved
by carefully copying one 5 pixel wide border to all 3 remaining sides and turning it
either vertically or horizontally. Without this you would see the border of the texture.
Minimize disturbances of the border pattern while working under very high
maghnification.

NAVAIDs in World-Maker

Ancient Roman sailors realized: 'navigare necesse est'... It is necessary to stay on course. They erected
lighthouses along the Mediterranean Sea, something we can hardly think of when flying above clouds nowadays.
X-Plane uses the standard aeronautical navaids, like non-directional beacons (NDB's), very high frequency omni-
range beacons (VOR's) and instrument landing systems (ILS's).

You can use World-Maker to edit and add these navaids, or simply open the "nav.dat" file with a word
processor. Here are the NAVAID types as defined in the "nav.dat" file:
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Look at the piciure (lefi) to see some NAVAIDy as
depicted by a Jeppesen chart.

From Maisach MAH VOR (freq. 108.4) your plane should follow radial 0501 to reach an intersection at "D12.0"
(12 mile DIVIE distance from (to) VOR DIVIN (freq. 116.0) along the 08L runway. This point is the "Final
Approach Fix", a point where the approach procedure starts. You now follow radial 830 on ILS IMNE at freq.
110.3 on the Nav-2 radio (set the HSI to the right heading). You are supposed to reach the FAF at some 5000
feet altitude IVISL (above sea level), which is about 3533 feet above the ground (AGL). Now set the autopilot to
HDNG Nav-2, ALT Nav-2 (a glideslope portion is available) and you'll automatically descend towards the runway
as the autopilot flies the ILS for you. Alternatively you can use the ILS portion in Nav-1 and the glideslope portion

When we start following the localizer and glideslope we will

in Nav-2.
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we do not see the runway or it's environment than we need
to go around (and execute the missed approach

Editing and Adding Navaids

Here is the airport data as found in "apt.dat” for KORD Chicago O'Hare Intl.

procedure).
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41.969040 -87.902382 9 R 90 10141 150 154154 41.991917 -87.903549

141.976776 -87.917770 14 R 140 13000 200 155154 |

14 L 140 10003 150 155154 668 1 KORD Chicago 0’Hare International

You would expect some NAVAIDs to be associated with this large airport, like
perhaps some ILS's, marker beacons, and maybe even a VOR.

Here we consider runway 09R and check the navaids for it:

3 41.975671-87.904900 650.0 113
O’Hare VOR

4 41.969040 -87.924774 647.9 111
Chicago O’Hare Intl

6 41.969040 -87.887520 668.0 111
Chicago O'Hare Intl

7 41.969040-87.789619 0.0 O
27L (KORD)

8 41.969040-87.873260 0.0 O
27L (KORD)

9 41.969040 -87.907625 0.0 0

27L (KORD)

20

10

10

0

270

270

270

ORD Chicago |

TSL ILS 27L

TSL ILS GS 27L

—— Quter marker
—— Middle marker

—— Inner marker




As you can see Chicago has a regular VOR (3) at the lat, lon, elevation, and frequency listed (with a heading of 0
for all VOR's) then the prefix and the name are displayed as well.

The direction for the ILS however is set to 270 degrees, which is the magnetic heading of the runway. The OM
(7), MM (8) and IM (9) are set to the airport's prefix, which is KORD. Also note, that 4 and 6 have the same
frequencies i.e. 111. 10, implying glideslope coupling to the localizer when the ILS is dialed into Nav | or Nav 2 in
your airplane.

Note: Misalignment of an ILS may cause a situation as shown in the left illustration. Be sure that your ILS
localizer transmitter is just off the far end of the runway with the exact same heading as the runway, and make
sure the glideslope is right beside the near end of the runway.

CHAPTER 5
PLANE-MAKER EXPLAINED

Introduction

In this chapter we will walk through the aircraft design-entry process. For engineers, this should be easy. For
pilots not as well versed in the fundamentals of aircraft design, fear not! We will explain things for all audiences
as we go.

. Launch "Plane-Maker",
e Go to the "File" menu and select "Open",
e Select an airplane, like the Mooney in the "General Aviation" folder that you wish to modify.

As we go through this tour, change any of the design data you want to
customize the airplane that you just opened. You then can fly the modified
design when you are done.

The Aircraft-Defining Variables

You will have to enter the locations of various parts of the aircraft (of course),
so the first thing you should do is pick a reference point (such as the top center
of the firewall, for example, or the back of the spinner) to make all of you
measurements from.

Plane-Maker will ask for the following dimensions for each part:

"longitudinal arm" (abbreviated "long arm"), which is the distance the item is
Start by defining a reference point! behind the reference point (use negative numbers for items forward of the
reference point).
vert arm
"vertical arm" (abbreviated "vert arm"), which is how far the long arm item is
above the reference point (use negative numbers for items below the reference
ref point long arm Pomt)-
\

"lateral arm", (abbreviated "lat arm"), which is how far the item is to either
side of the reference point. (All aircraft are assumed to be symmetrical, so most
lateral arms are positive, indicating simply the distance from the fuselage
centerline. In other cases, the lateral arm is positive-right. You will be able to figure out which convention to use
based on the situation).

at arm



Again, you may use any reference point you wish, just be sure to use the same reference point for all of the
items on each aircraft design!

Touring Plane-Maker's Menus

Ok fire up the program and open up a plane if you have not already and we'll start right away with
Plane-Maker's menus.

File Menu

New
This menu item creates a new aircraft file, suffix ".acr”

Open
This command opens the aircraft file that you want to look at or edit.

Save
This saves the aircraft file you are currently editing to the disk. If you are not sure your design corrections will
work, use "Save As" instead to avoid overwriting the original aircraft.

Save As

This saves the aircraft file you are currently editing under a different file name. Backspace over the old name and
give your design a new name.

Quit
This exits Plane-Maker.

Standard Menu

Viewpoint UTENFHTHT,
FANEL
The left-most box contains the airspeed-indicator markings. These speeds are EﬁngE;EE”BHCK
not used to determine airplane performance in any way, but are ONLY for e
airspeed indicator markings. Make test flights to determine specific speeds for TIRG 1
your design if needed. Be sure to set Vne high enough, because X-Plane will WING 2
break the airplane up if you exceed Vne! oG =
HORIZGNTAL STREILIZER
) ] ) ] UERTICAL STABILIZER |
Here is a quick review of the V-speeds in case you need them: VERTICAL STREILIZER 2
CONTROL. GEQNETRY.
e  Vso stall speed flaps down ("dirty" approach configuration) fedeibe ot e
e Vs stall speed flaps up ("clean" configuration) FUEL THMNKS OF FLOATS
¢ Vfe maximum flap extension speed (don't get them torn off) E:E;:EEFE‘T‘EEIRES
¢ Vno maximum rough-air speed or "normal operation” EETT B LT
e Vne maximum allowable speed or "never exceed" LANDLNG GEAR
L]

Mmo maximum allowable mach number (if required)

Don’t be overwhelmed by the design
The pilot's eye viewpoint is also entered here. This is simply the location of the ~ pRlors Yo See. VK seprby-step
pilot's viewpoint while flying. done, go quickly through the menus
again, chacking each item from top to
bottom. Once you have done that you
should be ready to fly.



Panel

Enter the instruments you want and the locations of those instruments on the panel by simply pointing and
clicking.

Note: glass cockpits are not as customizable as conventional cockpits, and helicopters do not have room for all
supplementary instruments.

Two different types of HUD are available. The "conventional HUD" works like the HUD of a typical fighter:
airspeed, heading, and altitude are displayed on sliding tapes, Course Deviation Indicators (a horizontal and
vertical line becoming a crosshair when on course) for targeting an ILS. Set the frequency of the required ILS in
Navl / GPS and Nav2. The "Hoops-HUD" projects digital map outlines as well.

Force-Feedback

Force-feedback joysticks are joysticks with motors in them that actually move the stick in your hands. X-Plane
supports force-feedback joysticks. Parameters that are relevant to force-feedback are entered here.

Note: In X-Plane you can set the serial port to output variables for hydraulic and electronic cockpit components
such as the "Rock 'n' Ride" seat.

Engines

Engine Type
Select reciprocating, fuel injected, turboprop, or jet here.

Number of Engines

For prop airplanes, enter the number of propellers here. If you have multiple engines going to one propeller, just
enter the number of engines as one, and enter the power of all the engines added together as their (total) engine
power.

Engine Specs
Enter the RPM, fuel consumption, and thrust data for your engine. The specific fuel consumption (SFC) varies
with the type of engine, and X-Plane will give you a default.

Engine Location and Cant (or "thrust-angle")

Enter the point that X-Plane will put the propeller for prop airplanes or the thrust-center for jet airplanes. The cant
is the angle the prop (for prop airplanes) or the exhaust of the engine (for jet airplanes) makes with the
centerline of the fuselage.

Props

Number of Blades
Your props may have 2, 3 or more blades each. Remember, this is the number of blades for EACH PROP.

Prop is Variable-Pitch
Enter "yes" if you have a variable-pitch (otherwise known as "constant-speed” prop). X-Plane will then adjust the
prop pitch in flight to maintain the RPM selected by you with the blue knob.

Propeller Radius
The length from the center of the spinner (or axis) to the tip of one blade of the prop. Don't confuse this with its
diameter, which is the distance from tip-to-tip of the prop!

Prop Chord
Enter the average "width" or distance from the leading edge to the trailing edge of the prop.



Prop Rotation Direction
Read the on-screen instructions carefully. The convention is a bit odd for helicopters, but makes sense for the
internal code of the simulator. You may assign clockwise (cw) or counterclockwise (ccw).

Design Point (RPM, advance and associated speed)
Enter the prop design point here. The design point is the speed and RPM that prop is designed for. It is probably
close to the climb or cruise speed and their associated RPM's, but this up to you! Test several options to see.

Prop Pitch Limits

When you fill data in the design-point boxes, Plane-Maker will guess at the pitch-limits automatically. You may
override Plane-Maker's guesses, though, by entering data here. As soon as you change the design point,
however, Plane-Maker will put in it's own best guess again. Be sure to enter zero if you have a fixed-pitch prop.

Wings

Note: For any surface (like wing numbers 2 and 3, vertical stabilizer number 2, or
whatever) that your design does not have, enter “Zero” for the semi-length. This
will tell X-Plane that your aircraft is not equipped with that particular part.

Semi-Length, Root Chord, and Tip Chord

Enter the "semi-length". This is the length of the wing from the root to the tip,
measured along the so-called 25% chord. This is the length of the wing from its
root to its tip, as measured along an imaginary lime that is 25% of the way back
from the leading edge of the wing to the trailing edge. See the illustration if you are
unclear on this. The 25% chord is generally near the wing's center or lift. You can easily join wings to shape

one complete wing. Each wing
becomes a wing-segment. Some

Note that the wing root is usually thought of as being inside the fuselage, at the alrplanes have unusual-planform
N . A . . ‘wings that can be designed in Plane-
aircraft's centerline. There are exceptions to this rule, but we usually put the wing Maker by adding Wing 2 1o the tip of

Wing 1, etc. Zoom in on your design
to see if both wings line up correctly!

root here, since air pressure from the wings carries over the fuselage to a large
extent. As far as the air is concerned, the wings really do go all the way to the
centerline of the fuselage!

wing-tip Enter the root chord ("width" of the root) and tip chord (“width" of tip).
Remember that the chord is the distance from the leading edge to '25% chord'
the trailing edge of the wing.

Sweep and Dihedral

Enter the wing sweep. This is the sweep of the 25% chord. Aft (backward) sweep
‘25% chord® g positive. Forward sweep is fine, just enter it as negative. The Mooney wing (see

illustration) has a slight forward wing sweep. Enter the dihedral (angle of each
o} wing above the horizontal plane). Positive (wingtip-up) dihedral is entered as
positive. Negative dihedral, or "anhedral" is fine as well. Just enter it negative. For
variable sweep wings this value is the MINIMUM sweep value!

\nlaing-root

Wing sweep makes sense above about 70% of the speed of sound or so, where
there is a large drag penalty associated with trying to meet the air head-on.
e Dihedral helps with stability in roll. If the wings have some healthy dihedral, the
oA plane will tend to roll wings-level, eventually, if you take your hands off the stick.
The drawback is that if you ever get into a SIDESLIP situation due to losing an
engine on one side or something like that, the plane will try hard to roll into the
sideslip because of the dihedral effect. (Sweeping the wings actually causes the

plane to act somewhat like it has dihedral, even if it really doesn't!)

trailing edge leading edge




Arms (Wing Position) Center of gravity

Enter the longitudinal and vertical position of the center of pressure Ref point

(25% chordline) at the wing root, which should probably be at the Pilot's view
aircraft centerline, or some point very close to it, or where the wings —
would come together if the fuselage were not there, see illustrations. =

Number of elements
Remember that the simulator works by breaking the airplane down o
into a finite number of elements, and finding the forcesoneach ~~ = ——————-

element. This is where you decide how many elements you want the
wing to be broken down into. The simulator will automatically break
the wing down into the number of elements you specify, with each element being identical in its span. (In other
words, the wing is broken down into a number of equally span wise-sized pieces). Enter the number of elements
you want to break the wing down into here. More elements allow greater precision in placing flight controls.

Wing location here

Incidence
Enter the angle of incidence for each element (or piece) of the wing. Positive incidence is where the wing has a
higher angle of attack than the fuselage. The AOA is what makes a barn door fly!

Enter whether or not each element of the wing...

Has an aileron trailing that pat of the wing

If your ailerons are on the outer 40% of the wing span, and you have 7 elements selected, then select the outer
(right-most) 3 elements as being equipped with an aileron. This is actually 43% of the wing for those with greater
math-skills...

Has a roll spoiler on that par of the wing
Spoilers can be used for roll control. Here you set them.

Has a flap and leading edge devices at that part of the wing

Just enter the elements with flap trailing. If you have full-span flaps, check all the boxes. No flaps? Check none.
Flaps that go out halfway down the wing? Check the inside (left-most) half of the flap boxes. The effect of slats
(LED's) can be set in the "Control Geometry" option.

Has speedbrakes on that part of the wing

Speedbrakes are like spoilers on the wing, only they are not used for roll. Instead, they deploy halfway or all the
way and increase your drag and decrease your lift. They may be used in flight or be deployed at touchdown
(airliner-style) for a proper breaking action.

Has drag-rudders trailing that wing element

The Northrop B-2, among other flying wings, has things that look just like ailerons on the wing tips. The
difference is, they split open rather that going up and down. This produces drag, which acts like a rudder for the
flying wing. You can try that with your flying wing designs here. (Just remember to enter a horizontal stabilizer
area of zero for your flying wing designs!)

Note to flying-wing designers

You can have the "ailerons" on the trailing edge of the outboard part of the wing deflect in unison to act as
elevators. You will use the "deflect ailerons with elevators" option in the "Special Controls" menu coming up
soon. Just select the part of the wing that has elevons as having ailerons on this screen.

Horizontal Stabilizer

Horizontal stabilizers are designed like wings, but with a special consideration: You need to select one of two
"stab types":



(a) Select "stabilizer" if you want the stabilizer fixed, with an elevator on the back (like on most Cessna's), or
(b) A "stabilator", if you want the whole surface to move with joystick deflection (like on the Sabre).

If you want the whole stabilizer to pivot with trim, but still want an elevator for pitch control (like on
Mooneys and Boeings) then select “stabilizer" here and set the “degrees of stab trim” at the bottom of the
screen.

Note: See the illustration in the "Wings" section to see how the location of the horizontal stabilizer is defined.
Wings, horizontal stabilizers, and vertical stabilizers are all placed in the same way.

Canards

If you want to fly a canard airplane, no problem! Just enter a long arm for the horizontal stab that is in front of the
wing. X-Plane will see that you have put the stabilizer in front of the wing and automatically deduce that you are
flying a canard. It will then reverse the elevator or stabilator deflections from a conventional plane to give the
correct response.

X-Plane will automatically cast downwash from the canard onto the part of the aft wing that is behind the canard.

If you are flying a conventional design, X-Plane will cast downwash from the wing onto the stabilizer or stabilator.
See the file " X-Plane.out" after flying your design to see what X-Plane is doing with downwash on your design, if
you want. Do this by opening "X-Plane.out" with your favorite word processor and using "Courier" as the font.

Vertical Stabilizers

—
vﬁl‘l stab
with rudder

The location of the vertical stabilizer is the same as for the other
flying surfaces. Look at the illustrations:

Notice that there are 2 vertical stabilizer windows.

canard
with
* elevator

Ref point

wing with
flap and

o]
long arm to vert stab

The Beech Starship has a
vertical stabilizer at each wingtip and

This is so you can have two vertical stabilizers. This can happen: a canard as i’s horizontal stabilizer

side by side ... like with the Beech Starship or F-22, or
top-and-bottom ... like with many pusher-prop planes.

If your design only has one vertical stabilizer, just enter zero for the span of vertical stabilizer number two.
Control Geometry

Set control surface sizes and deflections here. For the controls that you don't use (for example roll spoiler in a
plane without roll spoilers) just enter zero.

The "chord ratio" is the fraction of the distance from the leading edge to the trailing edge that the surface takes
up. Itis the part of the total wing chord taken up by the control surface. Almost all controls will be in the 15% to
25% range, depending on the control response required. If you have no blueprint or picture on hand it requires
some testing to find the optimum values.



Ailerons

Ailerons for roll-control might go up 20 degrees and down 10. If you are ) )
1. Leading edge device (slat)

simulating an existing design, measure the actual deflection 1 on a picture of 2. Speedbrake
the airplane or blueprint. If you are trying out a new design, you may end up 3. Roll spoiler
flight-testing these figures, seeing whether roll control "feels" acceptable with ;j ;'ifepmn
various deflections. 6. Rudder

7. Elevator
Elevators

Elevators for pitch might go up and down 20 degrees. Stabilators (where the
whole stabilizer moves for pitch control, like most single-engine Pipers) might
go up and down 16 degrees. You can use elevators or stabilators on your
airplane, but not both at the same time. You set which type you are using in the
"Horizontal Stabilizer" window, and then enter their deflections in the "Control
Geometry" window.

The deflection in the "elevator” or "stabilator" box in the "Control Geometry"
window applies to whichever design you are using. If you are using a stabilator
the chord ratio is completely meaningless since the whole surface moves, not
simply a part of it.

A and B, to form a more
acurate total wing shape.

Rudder Roll Spoiler, Drag Rudder, and Speedbrakes

Design them just like the ailerons and elevators. See the descriptions of roll spoilers and drag rudders in the wing
definition section if you don't know what they are.

High-lift devices

Select a flap by clicking on the select button. If your design doesn't use any flaps, don't worry about the current
selection. It is meaningless and has no impact on the simulation. In X-Plane Classic you can assign and use
flaps independently from slats.

Leading-edge devices (slats and leading-edge flaps) increase the stalling angle of the wing. Enter the stall-angle
increase that the leading-edge devices give your airplane, or enter zero if you don't have them on your machine.
In X-Plane 5x they are coupled to flaps.

Fuselage & Nacelles

Most of the contents in these windows are self-explanatory.

Fuselage coefficient of drag (c.d.)

The fuselage drag coefficient must include the drag due to fuselage/wing interference, fuselage/stabilizer
interference, and any other drag that is not accounted for by the wings, stabilizers, and landing gear. If you do
not have firm data on what the coefficient of drag is, you can make a guess along the following guidelines:

e Use 0.05 for a super-sleek machine (like the Lancair 360).

e Use 0.10is a decent guess for a reasonably "clean" airplane.

e Try0. 15 for a somewhat "dirty" design.

Remember, this is the coefficient of drag of the fuselage and miscellaneous appendages, including interference
drag, based on the frontal area of the fuselage.

If you want to get this data more scientifically, and you already have a coefficient of drag for your entire aircraft
that is based on the wing area, just subtract out the drag associated with the wing, horizontal stabilizer, and
vertical stabilizer to get the drag of the fuselage.



This requires an example:

Assume the coefficient of drag (at zero-lift) of your airplane is 0.015, based on a wing area of 150 square feet,
with a fuselage frontal area of 10 square feet. Let us further assume that your wings, horizontal stabilizer, and
vertical stabilizer have a coefficient of drag of 0.005 at zero lift. (In "Part-Maker" you may verify these numbers).

Follow this process to find the coefficient of drag of the fuselage, including interference drag, based on fuselage
frontal area:

Find Wing area
Find Horizontal Stabilizer area

150
30

e Find Vertical Stabilizer area = 30

e Add those to get the total airfoil area (150+30+30) = 210
e Divide total airfoil area by wing area (210/150) = 14
e  Multiply this by the airfoil coefficient of drag (1.4x0.005) = 0.007
e  Subtract this from the total coefficient of drag (0.015-0.007) = 0.008
e Find the ratio of wing area to fuselage area (150/10) = 15.0
e  Multiply this by the coefficient of drag (15x0.008) = 0.12

The final number is the fuselage coefficient of drag (including interference drag) based on fuselage frontal area.
Now enter this into "Plane-Maker". Fun, quick, and easy, particularly when calculated on a rainy afternoon!

Section Cuts

Drag the little squares around with the mouse to define the fuselage geometry. Close the window and look at the
airplane on the main screen to see the results of your handiwork. X-Plane will determine aerodynamic and mass
properties of your airplane based on the fuselage geometry, so enter this data accurately.

The frontal area will be used for drag, and the side and top area will be
used for lift and sideforce. The weight of the airplane will be distributed
across the airplane as well to determine it's angular moments of inertia. Distances
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/ Design fuel tanks, wheel fairings
Output and other appendages like floats the
same way you do the fuselage.

i
f

Weight & Balance

Center of gravity location

Enter the longitudinal and vertical centers of gravity. The longitudinal center of gravity may be close to or just
behind the longitudinal location of the wing that you entered in the "Wing" section. The vertical center you can
more-or-less guess... it's in the fuselage of the airplane somewhere. Scoot it up a bit if you are flying a plane like
the "Lake Amphibian" which has the engine way up over the fuselage. Scoot it down a bit for airliners that have
large engines hanging below the plane.

Weights
Enter the weights of the airplane. Empty weight is the weight with no fuel, water, or other payload aboard.
Maximum weight is the maximum weight you are allowed to fly at. The fuel load is simply the maximum fuel you



can put in the machine, the water load (used for forest-fire bombers) is the jettisonable load that you carry. There
will be a water-dump button next to the anti-ice button in the cockpit if your aircraft carries water. Dumping the
water over a forest fire puts the fire out.

Landing Gear

Gear Frontal Area
Enter the frontal area of all the landing gear apparatus, including wheels, struts, and gear doors.

Gear "contact-point" locations

Use this to set the landing gear tire contact point (with the ground) locations. Remember that the "longitudinal
arm" is how far back the contact-point of the wheel (with the pavement) is from the reference point, the "vertical
arm" is how far UP the contact point of the wheel is from the reference point, and the "lateral arm" is how far the
wheel is out to the side of the center of the airplane. Vertical arms are typically negative.

Nosewheel steering

This is how many degrees the nose wheel turns with full joystick or rudder-pedal deflection. 2.0 degrees might
work well for you. (Remember that in a real airplane, the nose wheel may end up being turned more than this by
differential braking). To see what your maximum deflection is, taxi around with 5-10 knots speed and one rudder
pedal to the floor, but without braking. If the movement is too "nervous”, waving the wings around, then lower the
deflection of the nose gear in the simulator.

The Expert Design Menu
Props, Wings, and Horizontal and Vertical Stabilizers

Variable Sweep Wing

Enter whether or not the wing has variable sweep (like the F-14 and B-1).
In this case the wing sweep will vary from the degrees of sweep already
assigned to the wing in the regular "Wing" window to the amount you enter
here in the "wing sweep" box. Control the sweep during flight by moving
the wing-sweep control in the cockpit. Aerodynamic effects of both wing
sweep and moving of the center of lift fore or aft are simulated by X-Plane.

Do Reynolds Number Interpolation / Extrapolation

"Reynolds number" is the air density times the speed of the plane times the chord of the wing divided by the
viscosity of air. (whew!) Experiments have shown that the coefficients of wings vary with Reynolds number. This
variation is usually fairly small and can usually be neglected for recreational purposes. If you use X-Plane on a
slow computer or just for fun then just leave the "Do Reynolds..." box unchecked, but if you want the coefficients
of lift, drag, and moment of the airfoil to vary with Reynolds number to get the absolute highest realism, then
proceed as follows: Generate two different airfoil data files with Part-Maker, each for the same airfoil but each at
a DIFFERENT Reynolds number. Save the files with names like:

"NACA 2412-Re=2-4 meg.afl" and
"NACA 2412-Re=4-5 meg.afl"

Make sure you assign the right Reynolds number to each airfoil in Part-Maker, and then X-Plane will interpolate
airfoil performance based on Reynolds number. If it can't interpolate because the Reynolds number of the
airplane is not between the Reynolds numbers of the airfoils you entered, it will just use the closest available
data.

Do Different Airfoil Root-To-Tip Interpolation



If you are using different airfoils at root and tip of the wing, then generate each airfoil file with the Part-Maker if
the right foils are not already included with the simulator, and check the "Do different airfoil root-to-tip
interpolation” box. This varies the airfoil linearly from root to tip. Otherwise save computing time by leaving this
option off.

Airfoil Selection
Click on the buttons to select the airfoil files you want to use.

If you are not doing Reynolds number interpolation, don't worry about the "Re#2" slots. They have no impact on
the simulator whatsoever.

If you are not doing different root-to-tip airfoils, don't worry about the "at tip" slots. Then they too have no impact
on the simulator.

Special Controls

JATO

Jet Assisted Take Off is a takeoff where a solid-rocket fuel booster is strapped onto a C- 130 or the like to boost
the airplane into the air in hurry, making extremely short-field takeoff possible. Just enter the location, thrust
direction (0 is straight back, 90 straight down), thrust force, and duration. A properly-mounted JATO will have its
thrust line go through a point close behind the airplane's center of gravity.

Stabilator / Elevator Differential Roll Deflection

F-22's deflect their stabilators in opposite directions to help roll. Question: How
will a Piper Arrow roll if you do the same thing? Answer: The stabilators are so
short you won't get much response. They can complement the ailerons, but not
replace them. This feature also works on elevator deflection if you are flying an
airplane with stabilizer rather than a stabilator.

This modified F-22 not only shows

Aileron With Elevator stabilator/elevator roll differential
The "aileron with elevator" coupling may seem strange, but flying wings might (see its horizontal stab), but also
use the same control surface for both pitch and roll. If the "aileron with elevator®  2ileron with elevator defeiction to

sustain high maneuverability.

coupling is set to 0.5 x the control geometry value of the aileron (i.e. 20'), then Flaps are in take-off position

pulling full back on the stick will deflect the ailerons up halfway, causing the

flying wing to pitch up. (Remember the flying wing has a swept wing, so raising the ailerons is like raising the
elevator on a conventional plane: it pushes the back of the plane down, raising the nose). This poses an
interesting idea for conventional airplanes: What if pulling back on the stick pushed the tail down (regular
elevator) and the main wings up (with aileron-droop)? This would increase pitch response and help lift the
airplane! This is something you might try on the Cessna 172. Note that a positive numbers pull the aileron
upward when the elevator goes up, and negative numbers will push the aileron down. Test this phenomenon
while viewing the airplane from the outside with the "I" key to see the controls move.

Anti-Ice Equipped
Anti-ice equipment keeps ice from building on the airplane in icing conditions. Watch the outside air temperature!

Arresting-Gear Equipped
Arresting gear is used for carrier landings. If you shoot a carrier approach remember to lower your arresting gear!
Use the little button in the glareshield’s auxiliary instrument bar.

Aural Warning Equipped
Aural warning system equipment warns you of being too low, coming down to fast, not lowering your landing gear,
etc.



Automatic Deployment

Automatic deployment of slats, brakes, and speedbrakes (like airliners have) can be had. You can also select
automatic wing sweep with flap retraction. This is used by the Beech Starship. As the flaps retract, the canard
sweeps aft to keep the plane in balance. This option only works with airplanes that have variable-sweep wings or
variable sweep horizontal stabilizers.

Speedbrake Frontal Area

Enter the frontal area of the speedbrakes when fully deployed here. This doesn't include speedbrakes, or
spoilers, that are mounted on the wing. This option only applies to speedbrakes that are mounted on the
fuselage (or maybe other places) that do not affect the lift of the airplane, but only the drag.

VTOL Controls

Vectored-Thrust
Designing a VTOL (Vertical Take-Off and Landing) aircraft is fun but challenging. Enter "yes" or "no" in the
selection box to indicate whether you want your aircraft to vector thrust or not.

The tilt-rotor VTOL (Vertical Take-Off & Landing) aircraft can obtain its
flight control in the same way a helicopter does: by adjusting what is
known as the "cyclic pitch" of the rotor blades. This is a process
whereby the pitch of the blades varies depending on where the blade is
on its trip around the hub. This creates a lift asymmetry that will pitch or
roll the aircraft. In this window you enter the degrees of pitch that a blade
is increased or decreased with full joystick pitch and roll deflections.

Another way to obtain control of a VTOL aircraft is to do it the
same way the AV-813 Harrier does: "puffers”. The concept is
simple. Bleed air is taken from the compressor and then sent out
through little jets on the tail and wing tips to steer the airplane
around when in hover. X-Plane takes the simplest possible
approach to simulating this. Just enter the pitch, roll, and yaw
moments associated with full joystick deflections. (Remember if
you don't know what the maximum moment is, just multiply the
force exerted by the puffer times the distance from the puffer to
the center of gravity of the airplane to get the moment).

If you don't know how much force you need, try some values to see if they give you comfortable authority. That is
what the simulator is for!

Note on propeller-equipped VTOL aircraft: The control that you are used to seeing as a throttle acts instead as a
collective pitch, with the computer controlling the throttle to maintain some rpm. This is how a helicopter is
typically managed. The collective pitch travel and redline rpm are set in the usual places for prop pitch and rpm in
Plane-Maker.

Artificial Stability

Unstable airplanes don't want to point in the same direction they are going. Once they start to point away from
the direction they are traveling, they continue to move away from the flight path! No human is able to fly such an
aircraft for long, so a computer is implemented in these aircraft to keep the airplane from ever diverging from the
desired heading and attitude. This computer system is called an artificial stability system, sometimes referred to
as "fly-by-wire" because there are no direct control linkages between the pilot and control surfaces.

The F-16 and airplanes that are basically just neutrally stable in hover (like the V-22 Osprey), have this control
system. This system looks at the control input from the pilot, then determines what the pilot wants the airplane to



do and based on this, looks where the airplane is actually going, moving the control surface to obtain the desired
result.

You will probably need an artificial stability system in your plane if it is unstable or is a VTOL design. If itis a
VTOL design, you may wish to have the system turn off at conventional flight speeds, and only "phase in" as you
slow down to hover. This is because there is little or no inherent stability in hover. (As first-time helicopter pilots
learning to hover can attest!) You enter the speed below which the artificial stability system is completely
engaged (say 60 knots) and the speed above which the artificial stability system is completely out of the loop
(say 180 knots). The system will automatically phase gradually from one extreme to the other at intermediate
speeds. If you are flying an unstable aircraft and always want the system to remain on, just enter a phase-in and
phase-out speed of 999 knots. The system will always be on below 999 knots indicated airspeed. Remember
that your true airspeed may be much higher than this at high altitudes, while your indicated airspeed is still under
99 knots, thanks to the thin air that causes the pressure on the airplane to be lower, and thus the indicated
airspeed to be lower as well.

The fly-by-wire, or artificial stability system, used by X-Plane is simple yet effective: You enter what pitch and roll
rates you want the artificial stability system to shoot for with full joystick deflections. Look at some examples in
the your airplane files. Output the control deflections to the graphical output display (Settings: Set Data Output in
X-Plane to see if the controls are moving too far or not far enough.

NOTE: To give you some grasp over this matter here are some average
parameter you can test:

Minimum speed: 160 KIAS Maximum speed: 380 KIAS

Low High
Pitch 40°  0.01 diff 10° 0.1 dift
Heading 4> 0.001 diff 4° .08 diff
Roll 40°  0.02 dift 20° 0.1 diff

Fuel Tanks / Floats / Wheel Fairings
e Flying boats have a floating hull with little balancing floats outward on the wing.

e Seaplanes sit (way) up and above a pair of floats.

Enter the floats for seaplanes here... the fuselage of your flying boat will serve for flotation with no extra work
required in Plane-Maker.

Engine Pylons
Engine pylons attach the engines to the wings of the airliners.

Background Menu
This is rather self-explanatory when previewing your work.

Special Menu
To clean up your design use the “Ellipse-Smooth” options. This will smooth out the fuselage a bit, kind of
blending everything smooth.

Switch to helicopter mode if desired, and the "Standard" menu will adapt from airplanes to helicopters.

Show with Textures or Wire frames as desired... textures are not available in X-Plane Classic.

"Output Texture-Map starting points" saves the outlines of all the parts of your plane to the "X-System" folder.
The various files are named "Start (item).bmp". You must substitute "Start" with the name of your airplane, for

example "Mooney wngl.bmp" etc. You can also customize your sounds and instruments panels. (Check out the
"King air.panl", for example, in the "King-Air" folder in the "General Aviation" folder). The same applies to



many engine sounds and warnings. See the various planes that come with the sim, and see the "Hacking
X-Plane" section at www.xicat.com for info.

CHAPTER 6
DESIGNING HELICOPTERS

Introduction

Most of the windows that you use to design airplanes are the same as the ones you will use to design your
helicopter, but there are a few that are different, so this short chapter will cover those windows that are specific to
helicopters. You should read the previous chapter on airplane design before you read this chapter to get a
tutorial on the functions of Plane-Maker that this chapter doesn't cover.

Main Rotor / Tail Rotor / Rotor System

See the descriptions for "Props" in the previous chapter to get a tutorial on how to enter the rotors into the "Main
Rotor" and "Tail Rotor" slots. One possible area of confusion for you might be the "design speed", or in
engineering jargon, "the design-point" of the rotor system. The "aircraft speed" box in these windows is actually
the speed at which air will be moving through the rotor disc, when the rotor is operating at its design point. In
other words: If the chopper is cruising at 90 knots, with the rotor aimed down 10 degrees, then the airflow
through the rotor disc will be:

90 x sin(10) = 16 knots

plus an additional 15 knots due to the air being "sucked" through the disc (this is also referred to as "propwash").
The number will be about 30 knots or so, as a rule of thumb.

Note: If the total propwash is 30 knots, then the airspeed through the rotor disc is only about half of that amount
(15 knots), because the rotor also pressurizes the air, causing it to continue to accelerate even after it has
passed through the rotor disc.

To summarize:

For a helicopter, the airspeed through the rotor disc in cruise is:

cruise speed x sin (rotor pitch down angle) + propwash speed / 2

This is an idealized approximation. Here is an even further simplification, if you don't have all of the data required
above:

design speed = cruise speed x 0.1 + 15 knots
Enter this number in the "aircraft speed" box in the "Main Rotor" window.

For the tail rotor, you should probably enter zero as the design speed, since tail rotors generally have no twist,
and entering a design speed of zero will cause X-Plane to assign no twist to the rotor.

For the flat and open pitch, measure the angles of the real helicopter with the collective stick full down and full up,
respectively. See the Pilot's Operating Handbook for exact numbers if possible. Be advised not to enter too high
a value for the main rotor pitch or you will stall the main rotor blades! -5 to + 15 degrees is normal.



Rotor System

These numbers are all self-explanatory, though be sure to enter the rotor
cants when the rotor is simply holding the helicopter at hover, and is not
deflected due to maneuvering. Notice also that the tail-rotor gear ratio is the
tail-rotor RPM ratio with respect to the main rotor and NOT the engine! This
number is generally close to 5. If the main rotor rotates at 384 rpm and the
ratio is 5, then the tail rotor runs at about 1920 rpm (as a rule of thumb). If
you set the tail rotor correctly then your helicopter will show next to ho yaw
when starting to hover. Check the helos that come with the sim for
reference values.

Skids

If your helicopter has landing gear rather than skids, enter "no" for skid
equipped. Otherwise enter the skid data that follows. Remember that the
skids are probably below your reference point, so you will enter a negative
number for their vertical arm!

Expert Design Menu
Main Rotor, Tail Rotor, Horizontal Stabilizer, Stability Augm.
See the "Expert" menu options in the previous chapter for an explanation

of this menu. Here you assign the rotor airfoils and add some stability
augmentation (if required) to the helicopter.

CHAPTER 7
PART-MAKER EXPLAINED

Introduction

Designing a helicopter is fun but
tricky. Start by looking at the models
that come with X-Plane.

The center of gravity should be right
under the main rotor. Main rotor RPM
might be 350, but bigger rotors
should turn slower. The main rotor
should have a collective pitch range
of maybe -5 to +20 degrees. The
main rotor should have a cyclic pitch
change of maybe 10 degrees. Over-
sensitivity of your helo means you
need to reduce your cyclic pitch. If
the engine can barely turn the rotor
then the rotor needs to be slowed
down or reduced in size. If the rotor
loses lift for no apparent reason
when you go to high collective then
you may be stalling the blades from
entering too much positive collective
pitch.

The tail rotor should turn about 5
times faster than|the main rator, and
have a pitch range of about -20 to +20
degrees. If the helo tends to yaw in
hover then you need to increase or
decrease the tail fotor pitch, size, or
speed. Be aware pf the direction of
rotation of the main rotor (which the
tail rotor must ¢
determine if the tai
strong or not strong enough.

X-Plane uses aircraft designed with Plane-Maker. These aircraft use airfoils designed with Part-Maker.

The "X-Plane Design System" comes with a number of airfoils and flaps. It is probable that, for recreational

purposes, these will be the only airfoils and flaps you will ever need. Additional models you might download from
our and other Internet websites may have their own airfoils and/or flaps, so always look for additional ".afl" and
"flp" files that you must copy into the "Airfoils" and "Flaps" folders first.

Part-Maker is available to you, however, if your airplane designs use airfoils or flaps that were not included with
the simulator.

The File Menu

The file menu works just like the file menu of any word processor or spreadsheet you have used. You create,
load, and save your files just like you do with a word processor. The only difference is that you are opening and
saving files that represent airplane parts rather than word processing documents. Your airplane will use these
parts.

New
Use this to generate a new part.



Open
Use this to open an existing part for viewing or modification.

Save
Use this to save a part that you have created or modified.

Save As
Use this to save a part that you have created or modified, but under a different name.

Quit / Exit
Exit Part-Maker.

Airfoils
Getting Started
Double-click on the "Part-Maker" icon. Select "Airfoil" from the "Part" menu.

A quick review for novice pilots: an airfoil is not a wing! An airfoil is simply the cross-section of a wing! A
Cessna 182 uses a NACA-2412 airfoil, and that may be the same airfoil that is used by various different
airplanes. These airplanes may have a different wing area, different wing span, and even a different wing
planform (shape) as seen from above the airplane and looking down. But if the cross-section of the wing is the
same for the two aircraft, then they are both using the same airfoil.

Every airfoil ever designed has its own characteristics, which are its
coefficients of lift, (how much the airfoil wants to lift up) drag, (how much the
airfoil wants to pull back), and moment (how much the airfoil wants to pitch

up).

What's an airfoil?
What's a planform?
What's a wing?

Airfoil + Planform = Wing

i

You'll see a big black box dominating the screen with green, red, and yellow _
Planform of a wing (its “top-view")

lines on it.
The left edge of the chart corresponds to an angle of attack of - 20 degrees, %
and the right edge corresponds to an angle of attack of +20 degrees. Airfoll or “cross section” of a wing

The center of the chart represents an angle of attack of zero degrees. (Remember the angle of attack is the
angle of the wing to the air. It is the angle at which the wing hits (or "attacks") the air).

The green line is the coefficient of lift. The red line is the coefficient of drag. The yellow line is the coefficient of
moment. We'll look at the behavior of each of these lines.

Reynolds number
The "Reynolds number" is simply the air density times the speed of the airplane times the chord of the wing
divided by the viscosity of air (Wow!). Experiments have shown that the coefficients of lift, drag and moment of

wings vary somewhat with Reynolds number.

For recreational purposes, you can probably neglect any change in performance with Reynolds number, so you
can just ignore this setting altogether The number entered in the Reynolds number box may have some impact



however on the simulation. For highest realism you can generate 2 different w1 - 15700

Reynolds Number
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generation screen without sacrificing a good simulation.

Coefficient of lift
Look at the green line. It is the coefficient of lift. e
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lift is fairly low. (It is close to the thin white line, which represents zero). As the isnon_isoog|
angle of attack increases, the coefficient of lift increases right along with it, until
you get to around 16 degrees angle of attack, at which point the coefficient of lift falls abruptly... That is the stall!

N

"\ Red line
N

reen line

Yellow line

Airfoil coefficients window

Lift

Moment

Coefficient of moment

If you go to negative angles of attack, you see that the coefficient of lift actually
gets negative. If you go to a large enough negative angle of attack, the airfolil
stalls then, too. It is possible to stall upside down! A good wing will have a
decent coefficient of lift (maybe 0.4) at angles of attack close to zero, and a
nice high coefficient of lift (maybe 1.6) at the maximum angle of attack. A safe
airfoil will also have a stall that is not too abrupt. In other words, the coefficient
of lift will fall off gradually at the stall, rather than sharply.

Coefficient of drag
Look at the red line. It is the coefficient of drag.

Notice that the coefficient of drag is lowest close to zero degrees angle of
attack. The drag gets higher and higher as the wing goes to larger and larger
angles of attack. That is not surprising, is it? The higher the angle you offset the
wing from the airflow, the greater the drag!

It doesn't matter much whether you are going to positive or negative angles of
attack (aiming the wing up or down)... moving the wing away from it's most
streamlined position increases it's drag. A good airfoil will obviously have the
lowest drag possible. (Notice that this drag coefficient does NOT include the
drag due to the production of lift. X-Plane will figure this drag out automatically).

Look at the yellow line. It is the coefficient of moment.

The coefficient of moment is the tendency of the wing to pitch up about its axis, or rotate upwards about the spar.
Most wings actually want to pitch down, so the coefficient of moment is usually negative. The moment varies a
bit with angle of attack, often in ways that are a little bit surprising. Typically the moment will be negative for all
normally-encountered angles of attack, getting especially large in the negative direction as the angle of attack is
increased, until the stall, at which point the moment heads back to zero. A desirable characteristic of an airfoil is
usually to have a low coefficient of moment.



Coefficient display box

One thing that you have probably noticed is that the axis are not labeled, and don't have numerical values to tell
you exactly what the coefficients are. Look at the little box in the upper left-hand comer of the airfoil generation
screen. The top number (white) is "alpha” or the angle of attack of the wing. The next numbers are the
coefficients of lift, drag, and moment at that angle of attack. Wiggle the mouse back and forth all the way across
the monitor, and notice that the angle of attack display changes, and the coefficients with it. The coefficient
display box is giving the angle of attack and coefficients of the airfoil at the angle of attack that the mouse is
currently pointing at. Just point the mouse at the part of the curve you are interested in, and look at the exact
coefficients in the coefficient display box! Easy!

One question you might be asking yourself is: How do | find what the coefficients are for the airfoils on my
airplane? First, you need to find what airfoil your aircraft uses, probably from the manufacturer. Then you need to
see if that airfoil is included with our program. If you are flying a Cessna 182, for example, that aircraft uses the
NACA 2412 airfoil, which is included, so you do NOT need to generate your own airfoil for that wing. If you do not
know what foil to use, then just leave them as the defaults of Plane-Maker.

Airfoil selection is a fun and interesting process, because you will be looking for the best possible combination lift,
drag, and moment characteristics for your particular airplane. If you will be experimenting with your own airplane
designs, and are new to the matters discussed in this manual, we highly recommend:

R/C Model Airplane Design
A.G. "Andy" Lennon
Motorbooks International Publishers and Wholesalers, Inc.

to get you started. The book is intended for radio control designs, but is very straightforward, easy to understand,
and all of the principles apply to full-scale aircraft.

Once you understand the basics of airfoil theory and nomenclature, we recommend:

Theory of Wing Sections
Abbot and Von Doenhoff
McGraw-Hill, New York (1949)

... an oldie but goodie! This books has the lift, drag, and moment plots of many airfoils in it, so you can choose
your favorite airfoil for your design and then enter it into the computer using the technique that is about to be
explained.

In the following discussion, thin symmetrical, thick highly cambered, and "normal general aviation" airfoils will be
discussed. These are three types of airfoils that are good for discussion purposes because they are so different.

Thin symmetrical airfoils are thin and have the same shape on both the top and bottom surfaces. They do not
produce very much lift or drag. They typically are used for vertical stabilizers and often horizontal stabilizers as
well because they are not called upon to produce a lot of lift, and are not expected to produce much drag, either.

Use thick, highly-cambered airfoils in the fore planes of canards, or other applications where you want a
LARGE amount of lift from a SMALL wing area. These foils are known for providing a large amount of drag as
the penalty for providing a large amount of lift.

So-called "normal general aviation airfoils", like the NACA 2412, are compromises between the two, and are
good candidates for the wing of a general aviation aircraft.

Supercritical, laminar-flow, and other possible groupings of airfoils exist, but for the purposes of our discussion
we will concentrate on the thin symmetrical, thick and highly cambered, and "normal general aviation" airfoils just
outlined.



Airfoil generation buttons

Now let's actually generate an airfoil. The first button to click on is the
coefficient of lift intercept button, the green one labeled “intercpt” in the
upper left hand comer. To increase this number, just click right above
the numbers that you want to increase, and below the ones that you
want to decrease. For example, if the lift intercept on the screen is 0.25,
and you want to change it to 0.33 to model your airfoil, just click right
above the "T' in "0.25" and twice below the "5" in "0.25". You will
change all of your data that way for the entire design and simulation
system. Easy! Now what exactly is a coefficient of lift intercept,
anyway? Read on to find out!

Coefficient of lift intercept, "INTERCPT"

This is the coefficient of lift at an angle of attack of O degrees. For a
symmetrical airfoil, this will always be zero, since the air is doing exactly
the same thing on the top and bottom of the wing for a symmetrical
airfoil at zero degrees angle of attack. Symmetrical airfoils are
sometimes used for horizontal stabilizers, and are almost always used
for vertical stabilizers. Sleek, skinny wings with low camber might have
a lift intercept of 0. 1. Fat, highly cambered foils have a value around
0.6. A typical airfoil like the NACA-2412 (commonly used in general
aviation) has a value of about 0.2.

Coefficient of lift slope, "SLOPE"

This is the increase in coefficient of lift per degree increase in angle of
attack. A thin airfoil has a value of about 0. 1. A real fat airfoil has a value
of about 0.08. Fatter airfoils have slightly lower lift slopes. (You will find,
however, that lift slopes are almost always very close to 0.1).

Coefficient of lift curvature near the stall, "POWER"

As the angle of attack gets close to stall, the lift slope is no longer linear,
but gradually "levels off” as it approaches the maximum, or stalling,
coefficient of lift. Just play with the power button until you find a power
curve that connects the linear and stalling regions smoothly. Chances are
a power of around 1.5 will work pretty well. Just play with it until the lift
comes up smoothly, then gradually levels off to the stall, since that is
what happens with a real airfoil.

Coefficient of lift maximum, "MAXIMUM"

This is the maximum coefficient of lift, or the coefficient of lift right before
the stall. A very thin, symmetrical airfoil has a value of around 1.0. A thick,
highly cambered airfoil has a value of around 1.8. A typical general
aviation foil might have a value of around 1.6.

Coefficient of lift immediate drop at stall, "DROP"

This is the drop that immediately follows the stall. For thin airfoils, which tend to stall sharply, this value might be

Airflow at various angles of attack

~.——

In the diagrams above, we see air flowing
over a wing at various angles of attack.
Note that the airflow is spead up above
the wing by the shape of the airfoil and
the angle of attack of the wing. Since the
air has to speed up to cover a greater
distance over the top of the wing, the air
molecules are spread out a bit as they
cover the greater distance. This spreading
out of the molecules means there is less
air pushing down on the wing from above
than there is below the wing pushing up.
This is effectively a suction on the top of
the wing, otherwise known as lift.

The diagram above also shows that air is
sucked up from below and ahead of the
wing by the low-pressure region above
the wing. This is sometimes called
“upwash”. The air is also given a healthy
kick DOWNWARDS as it leaves the wing.
This is called “downwash”.

Notice that as the angle of attack is a
maximum, air is almost pushing
underneath the wing, really pushing the
wing up AND BACK... this is an indication
that the drag of the wing is very high,
which is not surprising at high angles of
attack. If the angle of attack gets too
much higher, the airflow will seperate
from the wing altogether and the wing will
stall, thus losing the majority of it’s lift in
a great un-simulate-able turbulent mess
of vortex-filled air. You will notice this
loss of lift in the plane as it stalls.

0.2. For many airfoils, however, there is no immediate drop, but instead a more gradual one as the angle of
attack is further increased. In most cases, this number will be zero or very close to zero.

Coefficient of lift curvature after stall "POWER"

Different airfoils have different lift slopes after the stall. For skinny, sharply-stalling airfoils the power should be
fairly low, perhaps around 1.4. For fat airfoils (which usually have more gentle stalling characteristics) this



number may be closer to 2.0. Just play with the power button until the data looks like the data you are trying to
model from the airfoil chart in whatever book you are getting your airfoil data from.

Coefficient of lift drop from stall to 20 degrees "DROP"
This is the decrease in coefficient of lift from the stall to an angle of 20 degrees. This number might be in the 0.4
range, for a thicker airfoil, 0.6 for a thinner one.

The NACA-2412 has a value of about 0.4. (The coefficient of lift goes from around 1.6 to 1.2 as the angle of
attack goes from around 16 to 20 degrees).

Coefficient of drag minimum "DMIN"

This is the minimum coefficient of drag of the airfoil. (Again, not including

induced drag, which is determined automatically by X-Plane). This

minimum coefficient of drag also should not include the "low-drag bucket"

of a laminar flow wing. A thick or highly cambered airfoil has a value of

about 0.01, a typical older general-aviation airfoil such as the NACA-2412

has a value of about 0.006, and a real thin, symmetrical airfoil has about
~ a0.005 value. Laminar flow airfoils can approach values of 0.004, but

— ~ that number should not be entered here, because it will be addressed in

the laminar drag bucket buttons soon to come...

Wind tunnel image of an airfoil

e Coefficient of lift at which minimum drag occurs "MIN D CL11
Enter the coefficient of lift at which the minimum drag occurs. This value
is probably very close to the coefficient of lift at zero degrees angle of
When a wing produces lift the air in attack, which is the "lift intercept". The very first number you entered! If

FRONT of it is lifted UP, the air anything, the minimum coefficient of drag occurs at a coefficient of lift a
ABOVE it SPEEDS up, and the air little lower than the lift intercept coefficient of lift. This is because an airfoil
BEHIND it is pushed DOWN. usually has the least drag at an angle of attack of about zero degrees or

just a hair lower.

Coefficient of drag at angle of attack of 10 degrees "D ALPH=10"
For a thin, symmetrical airfoil, this value might be around 0.0 15. NACA-2412 comes in with a surprisingly good
0.0 12. A really highly-cambered airfoil might be around 0.025, though.

Coefficient of drag curvature "POWER"

The power curve is simply the curvature of the drag curve as it changes with angle of attack. You will have to
fiddle with the curvature until the curve looks like the experimental data, but theoretically this number will be
around 2.

Laminar drag bucket location "CL LOCTN"

Some airfoils, called "natural laminar flow" or "NLF" airfoils, have perfectly smooth airflow across a large part of
the wing, a flow pattern called "laminar flow". This super-smooth, low-drag flow can only happen at fairly small
angles of attack, though, so there is a "low drag bucket", or area in a small angle of attack range, that has lower
than-normal drag. The drag bucket location is usually thought of in terms of the coefficient of lift. In other words,
the center of the drag bucket occurs at some coefficient of lift of the airfoil. This might happen at a coefficient of
lift of around 0.6.

Laminar drag bucket width "WIDTH"
This refers to how "wide" the bucket is, or what range of coefficient of lift the drag bucket covers. 0.4 is a decent
guess.



Laminar drag bucket depth "DEPTH"

This is the all-important variable: how much do you reduce your drag by going to laminar flow? Answer: 0.002 if
you're lucky. (But that is actually quite a bit. That might turn a cd of 0.006 to 0.004. Quite a large percentage
difference).

Laminar drag bucket curvature "POWER"
The power curve is the simply the curvature of this low drag bucket. You will have to fiddle with the curvature
until the curve looks like the experimental data, but chances are this number will be around 3 to 5.

Coefficient of moment low-alpha change point "ALPHA 1"

The coefficient of moment is usually linear across the non-stalled angle of attack range. In other words, if the
airfoil is not stalled, the moment curve is usually a straight line. After the stall, however, the moment coefficient
tends to change direction. For the NACA2412, the moment coefficient has its low angle of attack moment
change at -10 degrees, a point corresponding to roughly +4 degrees before the stall.

Coefficient of moment high-alpha change point "ALPHA 2"
The NACA-2412 airfoil has its high angle of attack moment change right at the positive stalling angle of 16
degrees.

Coefficient of moment at -20 degrees "CM 1"

For the NACA 2412, this number is about 0.075. Notice that this is a positive number. This means that if the
airfoil is at a clear negative angle of attack, it will stall and try to pitch back up to an angle of attack closer to zero.
This is a nice effect, because the airfoil tends to try and recover from the stall automatically.

Coefficient of moment at low-alpha change point 11CM 211

For the NACA 2412, this number is about -0.05, which is a light pitch-down. A wing with a higher camber will
have a value of around - 0.10, perhaps even -0.13. A symmetrical airfoil will have no pitch tendency at all here,
s0 0.0 should be entered for that type of airfoil.

Coefficient of moment at high-alpha change point 11CM

For the NACA 2412, this number is about -0.025, which is a very light pitch-down. A wing with a higher camber
will have a value of around -0.10, perhaps even -0.13. A symmetrical airfoil will have no pitch tendency at all here,
s0 0.0 should be entered for that type of airfoil.

Coefficient of moment at 20 degrees 11CM 411
This is the coefficient of moment well into the stall. For the NACA 2412, it is about -0.10. This is a moderate
pitch-down, which is desirable because this pitch-down will help recover from the stall.

Finishing Up

Change all of the parameters we just discussed around a bit, and select "Save As" from the "File" menu. Now
type in a 'hi-tech’ airfoil name and hit return. Congratulations! You have just generated your own airfoil!

Flaps

flaps

Remember that you can design a lot of extended

_|_ _l_ realistic airplanes without ever generating
your own flaps, because plenty of flaps are
included with the program.

flap increase
in lift

~ _ Coefficient of lift

o

Getting Started
Angle of attack in the HUD “

of X-Plane is indicated by the
distance between these two

symbols. The + is the direction _ .
the nose is pointing, and the 0 is  LOOK at the chart (left), and notice that with the flap deployed, you actually stall

the velocity vector or direction the  at a lower angle of attack. This is due to the "induced angle of attack", which is
aircraft is moving. the effective increase in angle of attack you get from lowering the flaps, and

flaps
retracted

Select "Flap" from the "Part" menu. angle of attack



was shown as "up wash" in the previous pages.

If you are having a hard time believing that you stall at a lower angle of attack with the flaps deployed, go stall
your airplane clean, and then do it again with the flaps down. You will notice then that the nose goes up higher
before the stall when the flaps are retracted. Do this at a high altitude, with a forward center of gravity, without
anyone else in the plane, and only if stalls are approved. Go over your spin-recovery procedure before you do
the stalls!

X-Plane takes care of the "induced angle of attack" automatically, so all you have to do is enter the "flap increase
in lift" as illustrated above. Be aware, it is easy to misread the flap increase in coefficient of lift by not measuring
it exactly as shown on the chart!

So how much does a flap increase the coefficient of lift?

Flap type cl at full cd at full cm at full
deflection deflection deflection
plain 1.0 0.12 -0.30
split 0.9 0.14 -0.25
slotted 1.2 0.08 -0.38
fowler 1.4 0.08 -0.42

Remember the coefficients presented above are only what the flap adds directly to the wing. The "induced angle
of attack" from deploying the flaps will increase the coefficients of lift and drag on the wing even more when you
lower the flaps.

Play with the constant, linear, and quadratic buttons to get the lines to look the way you want them to. See the
high-lift devices included with the program first to see the trends. Notice that with lift, you get a lot of lift for the
first bit of deflection, but then go into a "point of diminishing returns”, where the last bit of flap deflection just
doesn't increase the lift much more. It is just the opposite for the drag, though. The drag isn't too bad at first, but
once you get the flaps out more than about halfway, the drag really starts coming up fast.

Finishing Up
Change all of the parameters we just discussed around a bit, and select "Save As" from the "File" menu. Now
type in a goofy flap name and hit return. Congratulations! You have just generated your own flap!

The View Menu

cl cd cm VS alpha

This view mode allows you to look at the coefficients of lift, drag, and moment as a function of angle of attack or
flap deflection. In other words, the angle of attack or flap deflection is the x-axis. It is best used during the entry
of the lift and moment data.

Cd cm VS Cl &: 00.117
¢z 01l

This view mode allows you to look at Gt 10110
the coefficients of drag and moment as =2+

a function of the' c.oeff|C|e_nt lift. In other e e R
words, the coefficient of lift becomes

DRAG

the x-axis. Almost all airfoil charts use [Cvesr [ sousne [ cooe
. . . [ooesa0[oos (o[ oao g
this format to present drag coefficients, -~

so this view mode is best used during
entry of the drag data. Only data up to =

the stall is presented. Thii aata must NOT contain \
the effects of induced angle

of attack.

Flap design window



CHAPTER 8
THE FLIGHT MODEL EXPLAINED

Many people have shown an interest in finding out exactly why and how X-Plane's flight model works. Well,
some of the exact details are proprietary to Laminar Research, but, since you asked for it, here is the general
explanation:

Step 1. Element Break-Down

This happens only once during read-in of the airplane from the disk. X-Plane breaks the wing(s), horizontal
stabilizer, vertical stabilizer(s), and propeller(s) down into a finite number of elements. You choose the number of
elements in Plane-Maker. The more elements you use, the more realistic the simulation. The maximum number
of elements you can use is 10. Studies have shown that there is not much of a difference between using 10
elements and 100... In other words, you need to use more than 4 elements, but once you get above about 10
elements you don't get any additional realism.

2. Velocity Determination

This is done twice per cycle. The aircraft linear and angular velocities, along with the longitudinal, lateral, and
vertical arms of each element are considered to find the velocity vector of each element. Downwash, propwash,
and induced angle of attack from lift augmentation devices are all considered when finding the velocity vector of
each element.

Propwash is found by looking at the area of each propeller disk, and the thrust of each propeller. Once the area
of each prop disk and the thrust of each prop are known, X-Plane simply looks at the air density and determines
how much the air must be accelerated for momentum to be conserved. Basically, for every action there is an
equal and opposite reaction. For every pound of thrust produced, a certain number of pounds of air must be
pushed back at a certain speed.

Downwash is found by looking at the aspect ratio, taper ratio, and sweep of the wing, and the horizontal and
vertical distance of the "washed surface" (normally the horizontal stabilizer) from the "washing surface" (normally
the wing), and then going to an empirical lookup table to get the degrees of downwash generated per coefficient
of lift.

3. Coefficient Determination

Once we know the geometry and velocity of the piece, we can find the angle at which the air hits each piece of
the airplane... this is known as the angle of attack. Knowing the angle of attack, we can look up the coefficients of
lift, drag, and pitching moment for whatever airfoil the airplane is using on that part of the airplane. This
information (the coefficients of lift, drag, and moment of an airfoil at a given angle of attack) as described in
Part-Maker but nature makes things a little more complicated...

The fact that the wings on the airplane have different aspect ratios (the wing span divided by the wing chord) and
different taper ratios (how much smaller the wing tip is than the wing root) cause the coefficients of lift, drag, and
moment to be a little bit different. The changes in these coefficients are called "finite-wing effects". X-Plane looks
up these effects in look-up tables that have been gained from experimentation in wind-tunnels. These effects
include:

e induced drag: Drag due to the production of lift.

o lift-slope reduction:  Reduction in lift gained per degree increase in angle of attack.

e clmax reduction: Reduction in maximum lift available from the airplane.

e moment reduction: Reduction in pitch-moment.



Even after these corrections, we must use a rule called the "PrandtlGlauert rule" to find out how much the air is
compressed by the airplane due to compressibility effects, and we also consider "drag divergent mach number"
to increase the coefficient of drag when we get close to the speed of sound... the greater the coefficient of lift, the
lower the speed at which we start to get high transonic drag.

4. Force Build-Up

We found the shapes of all the bits of the airplane during initialization. We found the speeds of all the bits of the
airplane in step 2, considering geometry, velocity, propwash, and downwash. We found the coefficients of all the
bits of the airplane in step 3, considering the effects of limited aspect ratio and taper ratio, and compressible and
transonic effect.

Knowing these, we can determine the force on each piece using the equation:
force= speed x speed x coefficient x area x air density / 2

Knowing the force on each piece, we simply add up all the forces on all the pieces to get the total force on the
airplane. Forces are then divided by the aircraft mass to get the linear accelerations, and by the aircraft moments
of inertia to get the angular accelerations. Knowing the aircraft accelerations, we can see what the plane will do
next.

5. Going over it again

Go back to step 2 and do the whole thing over again at least 14 times per second for each element on the
plane. Aren't computers great?

CHAPTER 9
TEXTURES EXPLAINED

The General Procedure

To make your own airplane textures for X-Plane and preview them in
Plane-Maker, simply create the bitmap starting-points by using the
"Special” menu "Output Texture Map Output Points" item. You'll find all
created files in the "X-Plane" folder. Replace the prefix "start" with the
name of your airplane followed by one space.

"fuse”, 11 nace", "misc". 11wngl", 11wng2", 11wng3", "hstb". "vstbl'
11vstb2", "pnl", 11 pyln", "fair" and "hand" for handles.

Next save those files in the same folder as the airplane itself.

For example, set the files up like this to texture-map the Citation Jet: Designing textures is fun, but
requires lots of work and practice to
X-Plane 5.52 Folder get the technical details just right and

the weathering just right that is

Planes Folder required to make the aircraft look

Biz Jets Folder real.
Citation X Folder
Citation Jet.acf (the plane itself)
Citation Jet fuse.bmp (left fuselage)

Citation Jet fuseR.bmp (right fuselage)
Citation Jet nace.bmp
Citation Jet misc.bmp
Citation Jet wngl.bmp



Citation Jet wng2.bmp
Citation Jet hstb.bmp

Citation Jet vstl.omp (left vert stab)
Citation Jet vstIR.bmp (right vert stab)
Citation Jet panl.bmp (cockpit panel)

Make sure that all your bitmaps are of sizes that are powers of two (2) (i.e. 32, 64, 128, 256, or 512).

256 x 256 recommended for the landscape bitmaps: grass.bmp, mountain.bmp, snow.bmp and water.bmp, stored ir
" Textures" and "Custom Textures" folders.

800 x 583 pixels obligatory for the cockpit instrument panel.
To edit the panel make a screenshot and edit the bitmap removing needles and other variable stuff, which
X-Plane itself will draw.

Make sure you save the bitmaps in 24-bit or 32-bit color BMP format, or X-Plane, Plane-Maker and World-Maker
will not be able to read them!

Some Hints on Textures

To add textures to your airplanes you'll need a graphics program capable of handling ".bmp" (bitmap) images.
Examples are PhotoShop and PaintShop, which have abundant features to create cool airplane and scenery
textures. When saving your textures look for the "File" menu option "Save a copy as..." to select the ".bmp"
format from the appearing sub-menu button. Filenames must be as defined on the previous page (for example
"Citation Jet wng2.bmp").

B-52H fuselage outline is
saved as “B52H fuse.BMP”
in the according” B52H”
plane’s folder

X-Plane supports hardware acceleration using the OpenGL standard. Hardware acceleration means that your
video card does the graphics calculations instead of the main CPU of your computer. The OpenGL video card is
designed to do things like texturing, fogging, light effects, anti-aliasing, and other stuff that makes the visual
presentation of the simulator exciting. The results are dizzying scenery and silky frame rates, creating a photo-
realistic environment.

Sounds can be added to your airplane as well. They must be in
WAVE format and stored in the appropriate airplane folder. They
can be special engine sounds, but also the other sounds, like the
screech of the landing gear! See the "Concorde" folder in the
"Mega-Planes" folder for examples. See "Hacking X-Plane" at
www.xicat.com for all the latest sounds, panels, and textures that
you can add!

Briefer

Run the Weather Briefer before your flight to get a weather forecast. If you have downloaded real-weather from
the net, then you will get an accurate briefing for the flight you have planned. See www .xicat.com for the current
places to get real weather from the net.



If you do not have real-weather downloaded from the net, then Briefer will give you a rather boring prediction. It
will simply tell you to expect the weather that is currently stored in X-Plane's preferences.
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